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i»"NE PAcw OL S‘| PL--tSZ""¢p «éu A"« ebcw POA
CAY¢ PLEZP OECAYCOLEZOSNROAGCAYCPLEZS'| OSNROALECAYCOLE
>_u<’!:At¢tw :pb¢ $ 2-10>€°£{-Ux Penalty(GXt) = A_GXt * exp(B_GXt
*GXt) pb{

+ Customize Penaltes- R hOuxzZAt ao A_SIXtS‘| BSIXtNY”"cAtz
°ia«ép A"« OECAY>> b”>O0—"tb{o°i~«ép A"«xzo®
0aU%VI\bi->™""1b{ A_SIXt S*] B_SIXtwexzii,U” TUC% "
h i»"NE p PAgw OL S| PL--tSZ”0°i-~«éy A«w POEC
AYCPLEZP OAcAYCOLEZOSNROAGAYCPLEZS| OSNROAGAYCOLES
_u<"l:Atw :pb¢ $2-10>€°£ {~Ux Penalty(IXt) = A_SIXt* exp(B_SIXt* IXt)
pb{

» Customize Penalties- R hOuxzZAt aoz
S‘| F-OSNRCOLENY’cAt®u-"¢

yo

F-PCPLEzZF-P¢OL £z F-OSNR¢PL £z
Q >O—"1b{u-"¢ :pxzbde

&"wsit "oz §"AUr«iz®ps$T>Q.. 1b{ Q :A¢0 OSNRfhx RX
ie”w Vt'loz OSNRzié”zthxfwitM¢§8"AU«"b" OSNR/i&”"
AU TAt*"Ewict hUlo BERwIi¢>rw SsipV’TU>t*tb{u

"¢ xéxz i»"NE PAcwe""rU iA OLS‘] PLt0Oo 2mc
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MCOSNRq (6"t 1mcmEwcts“tb¢ $ 2-10>€°£ {F-PCPLEZF-PCOLEZ
F-OSNRCPLEzS‘| F-OSNRCOLE<xz Q OAcAVYebs™j BERWICE>i&”
S'| OSNROACAVt!6 tb{-UxiwqS“pb{

U POECAYCPLE=QOAEGAY *F-PC¢PLE
U POECAYCOLE=QOAEGCAY *F-PCOLE
U OSNROZLEGAYECPLE=QOAEGAY *F-OSNRCPLE
U OSNROAECAYCOLE=QO&EGAY *F-OSNRCOL £

F-P¢CPLES'| F-OSNRCPLEXZ PL "A—=p°A”re”wWt0 0z F-PCOLES"|
F-OSNR¢OLExzU,U” i>C% hAc¢w OL "A—-p°AnretDb]{
$ 2-10 i»NE p"*Déoeae?
A
BER
INT)—
B
Ly
B
E

3 z Bi{ET U7

a )

TT’ o)

D

<

oL
PL IR —HIREER
OSNR [dB] 3
T 21tz 40Gbswx"Ai"AYa i»"NE pupxU”Are"E"0"d>O tb{
21 40Gbs wx"Ai"AYa i»"NE ppxU"Are"E"Uu"d
pbOU,O0EFcAY [dBm]

RX pné¢a TXwWwt Q P OAEGAY OSNR OFc¢P OE¢AY|OSNR O £¢
1D U X » 6 x"¢A FEC [pm] ¢OLE AY¢ OLE [EPLE AYePLE
Duo Binary | MZ Optimal E-FEC +12 0 1 0 1

Cisco MetroPlanner DWVDM 'O é&"2&i

[ oL-10358-01-J

" "mnm



H2 .  Cisco MetroPlanner t‘"E¢Aé"«f-

M 2.2y Cisco MetroPlanner O3&Twf

T 22tz 10Gbswt”Ai"AYa i»"NE ppxU”Are"E"0"d>0"1b{

T 22 10Gbs wx"A["AYa i»"NE ppxU"Ar-"E"0"d

pbOU,O0EFcAY [dBm]

RX pné¢a TXwWwt Q P OAEGAY OSNR OLc¢P OE¢AY|OSNR O £¢
1D U X » 6 x"¢A FEC [pm] ¢OLE AY¢ OLE [EPLE AYePLE
NRZ MZ Optimal E-FEC +25 0 2 1 0
NRZ MZ Optimal FEC +25 0 15 1 0
NRZ MZ Average no FEC +25 2 0 2 0
NRz EML Average no FEC + 100 0 3 3 0

T 23tz 25Gbswx”Ai"AYa i»"NE uptU”Are"E 0"d>0 1tb{

23  25Gbs wt"A{"AYa i»"NE pptU"Are"E~0"d

pbOU,O0EFcAY [dBm]

RX pé¢a TXwt Q [P OEGAY OSNR OFc¢P OE¢AY|OSNR O £¢
1D U X » 6 x"¢A FEC [pm] ¢OLE AY¢ OLE [EPLE AYePLE
NRz DML Average FEC +25 0 2 2 0
NRZzZ DML Average no FEC +25 0 2 2 0
NRZzZ DML Average no FEC +25 3 0 3 0
NRZzZ DML Average no FEC +25 3 3 3 3
NRZ EML Average no FEC +25 0 2 2 0
NRZ DML Average no FEC + 100 0 3 3 0

HA{,O 17 [OK] »«ee ¢« Fb{

226yNe cwo«pU”A

a2z 10%aizA " zYIAEIN yzS'|enuA’»0"p Ne ¢cro«pU”
Ab” gxziwgS“pb{ Export "UiA>—:b"gz"R hb,owN+ ¢> %o
ZIP Ne GUARA$D]

HA¢O 1 ToolsYCA”T’ Export >-R ¥b{ Export¥% 2é-@¢«pU Oretbe $ 2-11£{
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$2-11 Export ¥4 2é-D ¢«

pAcO 2 Export Vs 7é-@¢«up flenameNY "¢cAtNe. ¢ ingE2>O0—"1b{7 Neo
cto«puU”"Ab"Ouxz @iy« z2&~sAYe«AxeS'|Ne ¢t
““tb{ [Select >«ae¢« 0oNe ¢>aR tb{

HA¢O 3 o«uU”Ab”2 AU>-Rb"hStzZAs@C>O—"$b{

« User Optione Tools > Options UTApf “ha”?2 103ai>a«pU”Ab 00
t-R th{

o PartsDBe &~sO&¢AN¥"U>-R $b{

e PriceDBe b,owA " Ho«pU”"Ab"Oux All Price DB >»- R tb{fhx All
Price DB>2 %0 0za«pU”Ab"X ' WA" H>=R $b{

HA(',O 4 [Ok] »«ae¢« fTh{

Cisco MetroPlanner DWVDM 'O &”341 A
[ OL-10358-01- .m



H2 .  Cisco MetroPlanner t‘"E¢Aé"«f- |

M 2.2y Cisco MetroPlanner O3&Twf

227yNe ¢cw TU”A

a’2 10%aizA " zYiAEipn yzS'|aeuA’»0"p Ne ¢> T1U"A
b” gqxziwgS“pb{e«pU”"A hé:wz AUT's” ZIP Ne ¢> iU”
Ab"\qczx'w TXT Ne ¢> TU”Ab"\q<pVib{

pHA¢O 1 ToolsYC&A”T’ Import >-R tb{ Import¥% 2é-@¢;«uU O etbte $ 2-12£{

$2-12 Import Ya 26-D ¢ «l

HA¢O 2 Import¥s 2é-@¢«pup ..D@»ir«ceei« z &~sAYe«AaS‘|Ne ¢t ™
tb{ [Select r«ae¢« 0 TU"Ab"Ne ¢>-R 1b{

pHA¢ O 3 J[load] >«ae¢ « Th{

HAcO 4 TXT Ne ¢> 1miZz-R hOuxz\wuA¢Os2t o HAcO 5t “tbh{o«p
U"Ahé:w!O3&iT's” ZIP N+ ¢>=-R hOUxzZAt aoiw@C>0
—thb{
» User Optione Tools > Options UTApf ~eha”2 1O03aiw feoM"N-

¢> TU"Ab"Ouxz-R 0SVib{

« PartsDBe ¢$WOAa:,AN¥"Ut0 b"a@ %A »0"u> iU"Ab”Ouxz-
R0SVib{

e PriceDBe b,owA "> iU"Ab"Ouxz All Price DB >=R 0SV%b{th

Xz=Rort oz pb”"x'wWA”" >=R 1b{
HA(',O 5 [Ok] »«eae¢« tbh{

MPAL,O 6 Y ;% 72é6-Q¢«ppz [Ok] »«ee¢ « Fb{
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228yAN¥cA & Z¢Awae ¢ A

~4ANVYe¢«w @ ZCAWf «xz Cisco MetroPlannew 4 fit- "+t b{isz Cisco
MetroPlanner> | " hqVtxz4fliq% aé 2¢AU O"retb{AN¥cAw-4
RNVe« & 26Atxz0 1> Ob"Tz_nb"TqMIhoeU tetb{

Cisco MetroPlannew AN¥¢cA & Z¢Atibtxz View YC&” T’ Default Layout >~ R
“tb{a”2U!E hé z¢CA>Tib"txz View YCA"T’ My Default View >-R
“th{

229y0&4- iwacC

=
>
[

=
>
-

=
>
-

=
>
[

(@}

(@)

(@)

w

(@}

Cisco MetroPlannert O 4 - i>&4Cb” gxziwgS“pb{O&- ix Cisco
MetroPlannergx xteea”u”etb{ O&- i>—;b"qz @eae’u 17 aiw Cisco
MetroPlanner § u» U TpVib{

Documents and Settingsernamiesktop\MP7\pluginsN ¥ ¢ ¥4t O & - i Ne ¢> D" ¢
b{

File YCA"T' Exit>-R'0 [Yedr«ea¢«b”Tz [Nos«eeg« 07 06 £«A
>- “¥b{

Cisco MetroPlannes | " b {AltmMoxz ®2.1y Cisco MetroPlannew | =~ ¢ p.2-2£ > €
°ToXirtM{

Tools > Plug-In > View Plugin registry wqt-R " b { Plugin RegistryYs Z2é-~ @ ¢ «pU™
Onretbe ¢ 2-13£

$ 2-13  Plugin Registry Y4 Zé-@ ¢«
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pHA¢O 5 Plugin Treepzy MO&- i N¥c¥irE«wae s« z38"A8¢ A YCAa"T’' Expand
»=R tb{
HA;O 6 Yy MO&- iI>Ewae¢« z38"A8¢ A YCA"T’' Runatstart >=-R 1b{
MA¢O 7 [OK] >«ee ¢« by
HAL,O 8 Y ;% 72é6-@¢«pupz [OK] >«a ¢« Th{
pA¢ O 9 CiscoMetroPlannet 4 z61" tbh{y " MO&- iU File YC4"w<w UiAq®
0 Onretb{

2210y0&- iw ¢

O&4- 1> 00 gb” gqxziwgqS“pb{0&- iwdCtmMoxz ®2.2.9
O8- TWAC™ ¢p.2-21£5€° 0Xi*M{

pHA¢ O 1 Tools > Plug-In > View Plugin registy wqt-R 1 b { Plugin RegistryYs Z2é-~ @ ¢ «pU™—
Oretbe  $ 2-13%

pA¢ O 2 Plugin TreepzO&- i N¥c¥irEwae¢« z28"A8¢ A YCA"T’' Expand>-R
“tb{

pAsO 3 08— ihwai« 0z E@C> O Fb{ Plugin Registry¥%s 2é-@ ¢ «pwEO

itzO&- 1GCU O”etb{

e PluginRegstry¥s 2é-@ ¢ «uw Generalaeezpziw@C>-Y 1b{
Names ¢ Ow £08- iwE2U O7etb{

Pathe ¢ OW £04&- iw- OtU O7etb{

Versione ¢ Ow £0&- iwi” iU O"etb{

Providere O&- iw ™MiwE2U O~Metb{

Texte ¢ OW £08- iw ostiU O”etb{

Exclusions ¢ " Ow £fZ40¢U O"+$b{tZ QxzO0&- TwtZg"
¢> [b"»-pb{t wtZ»->! "0z6:wO&- i>%litieeb”
\gxpVidee{

T T T L L T

+ Plugin Registry¥s 72é-@ ¢ «uw StatenaezpzO8- iwqOwY6S‘|MVvAQ
saY 1b{

iU CurrentStatee ¢ Ow £08- iwYBUO”etb{

i Canbe stopped ¢ Ow £ TruewOuzqOw Cisco MetroPlanner ¢ 34intz0

&- H>A®tpVib{0&- ix File YC4a"t O"resXs“th{ -~
dhO&- 1>6%b”"txz Cisco MetroPlanner 4 f "061"b"ZAUK"*$
b{ FalsewOuxz Cisco MetroPlannewz«AYO -¢3aiatO&- 1> -p
Videe{

n Canbesuspend ¢ " Ow"£ TruewOuzqOw Cisco MetroPlanner¢ 34iatz0
a- H>A®tpVib{0O4a- ix File YCAa"t O”esXs“tb{n.."
hO&- 1>6%b"txz Plugin Regstry¥s z2é-@ ¢ «up  Resume>-R tb{

Cisco MetroPlanner DVDM ! O @”3 47 " A
m. OL-10358-01-J |



| H2 -  Cisco MetroPlanner t'"E¢A&"«f -

2.2y Cisco MetroPlanner |O2&iwf ||
Cisco MetroPlannerw 4 f 061" b”"ZAXxK*“1+da/{ False w O U x zCisco
MetroPlannerw Z « AY O ¢ 3aiat\wO&- i1>°1 - 0T’ 6% b”\

gxpVidoe({

e Plugin RegistryVa 2é-@ ¢ «uw Run Informatione &2 2tz Can be deactivates Y 6 U~
Onretb{ TruewOuxzO&- i> -Y6tpVibUz -> ®th"txz

Cisco MetroPlannes4 f "061°b"ZAUK"“1b{ Cisco MetroPlannes 61" b " q z
File YCA"tO&-~ U OnresXs“th{ FalsewOuxz\wO&- i> -Y
6tpVidoee({

HA¢O 4 O&- i>A®tb"zthx°]l -b"txz0&- iI>E«ee¢« z3a"A§¢ A
YCa"T iwMceT>-R tb{

« Do notrun at start Cisco MetroPlannew is|”itzO&- i>A®tb”"Out-R"

Ib{
+ Suspend/Resume Cisco MetroPlannes 61"~ sMpzO&- i>hijtA®tb” 0
Uxz Suspend>-R tb{°l -"hO&- i>—;D6tb"txz Resume > =
R fb{
A, O 5 [OK] >«a¢« b{
PA¢O 6 Y Y 2é-Q@¢«pupz [OK] s«ae ¢« tb{
pAsO 7 Donotrunatstart-R hOuxzO&- i>A®tb”hStz Cisco MetroPlannes 4 f °
061" 1b{

2211ya"2 OéNes ¢gwéacC

a”2 0OéNe ¢cxz Cisco MetroPlannesfeeb”Out—:b"° EwVvpb{OéN-«
¢clqtYs”;6> ™M tb{ Cisco MetroPlannew [ ¢ -” tx z Network Designers *
| Base Network DesignefM OO éNe ¢U feoMibUz3p U ™M oM”"fw w

a’2 OéNe ¢>a”2 paCpVib{ ° Cisco MetroPlanner DWDM Operations Guidev
gxb,oz Network Designew Z « -pVUK”a"2>Y “o{TesoMtb{

T 24tzav2 OéNe+ ¢ Network Designery Base Network Designerp Ys”Vv>O ™t
b{fw w UiAs‘|!O3&aixb,ozrj’wa”? OéNe ¢cc%aVvpb{

2-4 Network Designer S*‘| Base Network Designer pYs”"Vv

Cisco MetroPlanner “U7TA /'03ai Network Designer Base Network Designer
Tools > Parts Database > New group

Tools > View Plug-in registry

Tools > Options > Platform Options > D iT e
Restricted Equipment list

Tools > Price List Mgmt > Master Price Database | D iT e

Tools > Export

Tools > Import
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Cisco MetroPlanneta”2  OéNe ¢>&Cb” gxziwgS“pb{

pA¢ O 1 Documents and SettingsernamiDesktop\MP7\profilesN ¥ ¢ %tOéNe ¢ JAR Ne ¢>~
P " tb{
pA¢ O 2 Cisco MetroPlannes |~ tb{AltmMoxz ®2.1y Cisco MetroPlannew | =~ ¢ p.2-2£ > €
°roXirM{ Choose a profile typeAé ¢ Ovu¢i @pAty MOéNe cU ONet
b{
2.2.12yp.«%()AWT%
n«eOA>Taeb” gxziwgS“pb{p«ee OAxz BSHNes ¢ Uw°Ew Ui

ApK*“z Cisco MetroPlannew&C;6> ™ tb{3p 3uAUpxz

Cisco MetroPlanner
i1NACE£ZwEpu»U fthgm ®su«aeOAs>; ™ oMib{

C«fE \w g>Taeb”2tz3u 3pAUTT ®sp«xeOA>0 "0SXZAUK*“%

b{

pA¢gO 1 ScriptYCA"T’ RunScript >mR 1 b{

pA ¢ O 2 Choosethe scripttoruth 2é-@ ¢ «upz&~sp«aeOAs«a« 2 [Open] > «ae ¢ «
“tb{p«ee OAUTa@ e Eb{

HA¢O 3 p«aeOA>6ieb”Ouxz Run Again> y«a2 OAE wqt-R $b{

2.2.13yScript YCA"WEY

Cisco MetroPlannepn«se OA AYé«AaetK"2ep«aeOAxz
OnrezK’e”a”2UlaepVib{

C:/Documents And Settingadser-home¥MP_<version>/scripts w & ” 2
menup OMetb{

Script > Common menyp ~

n«ee OAxz Script > User

MceTwAYé«Aampu«aeOAwaCthx_tralhgqVxzic Refresh Dirs > = R
“z Script YCA"tIEUSEéN«" Ot oXi*M{ Remove Dirs  UiA>—;b"qz
Script > Run AgainY Ca” T ' p«ae OAEU _thez Script > CommonY C&4”" S| User Y
Ca"UEyretb{
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23y0é £«Aw”R

Oé E£«AxzisS'|ztw0AQqs”0°E¢gAé"«thxo:WE A& " «plR
NeoMEDb{Oé E£«Apxz%aSu»U"O—A"»pz0°EsAé"«w D">6
—;pVibUzé:wled”3ai>U|b”hStz D"]qtYs” ! O34&i>-

; 1b{
Oé E£E«AtE¢ A& «> 1 mMARDb” gxziwgS“pb{y ME¢ A&"«x
DesignuA”A¢Y6£ts“tb{n E¢gAé "« HA”AwAlItmMoxz  ®27yE¢A
8"«f-w g ¢p.2-90£ >€° 0 Xir"M{

pHA¢O 1 File YCA"T' New>-R tb{ ProjectCreationt Y2"AU O”etb¢ $ 2-14£{

$ 2-14  Project Creation ¢VY2"A

pAsO 2 Projectd” piw@C>O—"1b{

. Created By 4"2wé- iEU OMNetb{\WNVY”"¢AXx!'ED6pbC7G 128
EE {

« Costomer Name \WE A& «f->A{"oM”"8u»U"WE2>0—"1tb¢7G
128 E£ {

+ Network Platform Layoutr Aé;O%¢i @pAT’ ANSI¢z wWF £Fhx ETSI¢ M
F'£>-RzO8¢AN¥"U » O>! “fb{ ANSI E¢; Aé"«wOuxz SDH

CETSIE+"Tp  AUTA> [pVidoe{ ETSIE¢;Aé”«wOuxz SONET¢ANSI£E
+"Tp AUTA> [pVidoe{
+ Span Measurement Units Aé ¢ O%e¢i s uAT KmeO©EéY AcEthx Miles > =
R zuii®Gw- oe>f “fb{
Price Liste Aé;O%it¢i s&uAT A" H>=-R 1tb{
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pHA¢ O 3 [Next] >« ¢« b

HA; O 4 PlatformO” pz&~sO&:;AN¥"U>-R z [Next] >«ae ¢ « 1h{

HA¢O 5 ReleaseO” pE Aé"«f-t0 b"&~stNACE?Z @e”u>-R z [Nexi] >«
@i« tTb{AN¥cAx7yaeeae"upb{\w Qt'loz> waea upx+xU”A
NesM\qUg pzf-t—;pVSME"A¢CE£7aeVawa pnAU [*e1b{

pA¢eO 6 Subnetd” piw@C>0—"1bh¢ $ 2-15£{

 Traffic mappings ONS 15454 Release 710" aiw i»"N£ pS‘|pOc”AYi
~78&=72¢°@TU>E¢ A8 "«f-p—:b"Out-R tb{ Release 7.0k <« *
6QUK”"wpz Software Release 427/5.0zS‘| 7.0> gpVib{

+ Metro Cores ONS 15454 Release 710" diwZ¢° e U>—; 0z+OE¢ A& "«

Cwyi+St| DCUw ">7&=b"00t-R fb{ Release 7.0x<+*“6 QUK
"wpz Software Release 4275.0zS‘| 7.0> gpVib/{

+ lLayouts +OE;A&"«°wox Aweé 2CA>"Rb"qVt—;b"z ONS 15454
Release 7.0" diwzc°aeTU> [b”Out-R tb{ Release 7.0x<+“86 Q

UK”wpz Software Release 4275.0zS‘| 7.0> gpVib{

e Bandse C-Band $hx L-Band >-R $b{ L-Band >—;pV"wxz Release 7.0W E ¢
Ag"«tv’'etb{

+ Scalable C/[LBanda Yesthx No>-R'0z %°3pAUip CliiAg LITAwtM
>+ U"ApV u-"&le@AY>f-1)Q"TroT>! “tb{\w!O34&i>
—:;pV"wxz Release 7.EE ¢ A& " «tv’'ez 't C-Band>-R oM”Oupb{

+ Scalable C-band/50GHz Yes $thx No>-R oz CIiiAp 50GHzw®%REc ">+
U"ApV u-"8ieAY>f-t1)Q"TrOT>! “tb{\w!O3ai>—;
pV"wxz Release 7.CE¢ A& "«tv’'ez't C-Band>-R oM”"Ouphb{

e C-bandRules E¢Aé"«f-tSZ"z%REcp“wW7Gié"S'|%LREG "t
s"103%41>-R tbh{\w!03%&i>—;pV"wxz CiiA>-R hOup
b{ CliAwOuz!O34aix C 64Chs 50Ghe +2dBm/ChEw UpO~retb{—;p
V"%BREG:x 64z32z16zthx 8 pb{%RE¢ [&"]qw,jt ‘o—;pV
"1O3%&ixz —-1dBmz2dBmz5dBmzS*‘| 8dBmpb{—;pV"n0O"3i- e}
387x 100GHzthx 50GHzpb{

« L-bandRuless E¢A&"«f-tSZ"z2%RECPp“W7GI&"S |BREC "t
s”103%ai>-R tb{\w!03%4i>—;pV"wxz LitA>-=R hOup
b{LIiiAwOuz! O24aix L 32 Chs 100Ght +5dBm/Chtw UpOretb{—:
PpV"%REG:x 64z32z16z%hx 8 pb{%RE¢ 1é&”]qw,jt ‘o—;p
V'1O348ixz  -1dBmz2dBmz5dBmzS‘| 8dBmpb{—:pV pnO"3i- !
O3&ix 100GHzthx 50GHzpb{
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$ 2-15  Project Creation ¢Y2"Aw  Subnet O"°

HA¢O 7 [Next] r«ee¢ « 1h{

pHAesO 8 IwMceTw g>fae thb{

« Network Creation¢ Y2”A>teeb"Ouxz Run the Network Wizard Now Y% £ ¢ « @ ¢, «
p>- Rz [Finish] »«ae ¢« Th{ HA¢O 9t “fb{
e fWOé £«A>~"Rz "px Aq«Ne 1>&Cb"Ouxz Run the Network

Wizard Now L E ¢« D¢ «uw-R>rt°z [Finish] »«a ¢ « 1 b{ Project ¢ Y2” A
t'100é £«AZIWEAE"«S |2OE¢A8"«UARNMNezFL "p

+ AS'|«Ne 1>aCpVib{\wOuz'“w g>2t th{+ A> "~

paCb” gtmMoxz ®23.1ly+ AwWAC~ ¢p.2-31£>€° 0Xi*"M{

pA¢ O 9 Network Creation¢ Y2”Aw  TopologyO” ¢ $ 2-16£pz TopologieswAé s Ovcti e pA
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$ 2-16 Network Creation ¢Y2"Aw Topology O"°

pA¢ O 10 ConfigurationO” pz Site numberNY "¢cAt+ A:>O—"z [Next] r«ae¢« tb{ Eg¢
A «f-p*w7G+ A:x 60zAN¥cAw+ A:x 3pb{
pA¢ O 11 Site Managemen®” piw@C>0O—"th¢ $ 2-17£{

+ Shelf Management 3£¢N gwf >R tb{

i Multi Shelf Integrated Switch  Multi Service Transport Platfor;qMSTPE« §"A¢ I OAY
§¢c AddDropUc%Oé«+ [OADM] S‘|yi+£xb,0z LAN t10€ 7o
hzfegeVs"3£cNt "Aeth{ LAN x MSTP3£cRNtE Aehp ¢
Yopi+retb{\w!O3&di>-Rb”"qz Multi-Shelf Integrated Switch Card
¢CMS-ISCE>—; 0Uc%3EcNiIRU U Areth{

U Multi Shelf External Switche b,ow MSTP «§”A¢ OADM S*|yi+£xz LAN p
€ NehfegeVs 3E£gNt "Aetb] LAN x MSTP3£cRwZeap ¢
Y%pi+~etb¢  Cisco Catalyst 2950 {\w!034i>-R hOuxz 2 mwZea
"tEGA  p ¢%o—;"0zUcg%IEGNIR>+U"A tDb{

i Individual Shelfs b,ow MSTP«§"A¢ OADM S‘|yi+£U% a3£¢Nt ”
Netb{\w!034ai>- R hOuzUc%3EcN gxxU"Aretfdoe{
3£cN]gt g h3f£¢Ng o g fb{

+ Node Protections Same Shelt 0°3£¢NIREThx Separated Shelveg U ¢ %3 £¢ N
iRE>-R'tb{  SameShelfiRpxzb,ow  OADM/ROADM +”"U 1 mw?3£¢Nt
"Nez3£¢N eOcpxE"Atrw'Os-¢« ™M tdoe{ Separated Shelveb
Rpxzb2VgfzVw OADM/ROADM +"UE”Aop ‘w3£¢Nt "Aetb]
\w!O2&ai>-RpV "wxz Multishelf g>-R hOQuiZpb{

e Hybrid Node « TR”ehb,owE"A>E Oa¢A MSTP/Multi Service Provisioning
Platform¢ MSPPEE"Aq 0~ "Rb"O0t-R £ b{ Hybrid Node > —; pV " w x z

Shelf Managemens O q o  Individual Shelf>= R hQOuiZphb{
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Osmine Compliante \w!O3&ixz Operations Systems Modifications of Intelligent Network
Element® OSMINEEL "F t,nMoz3£¢Nt DWDM +”> "b”Out-R t
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DCC chaine DCC>—;b"a+ Awa3f£cNpzuégA 12t TXP(P)_MR_2.5G§"

A>eLb”Out-R tb]{

Max ShelfNums + Awe 2¢AARItz: Awod;«t "pV"¢«8§8"At
hx TXP/MXP §"A>+< hf  ANSI thx ETSI3EcNw7G: ¢1 ™4£-R th{

$ 2-17 Network Creation ¢Y2"Aw  Site Management O"°

HA¢ O 12 [Next] >«ae ¢« 1h{

pA¢ O 13 Span Parametersziw@C>O—"1b¢ $ 2-18£{

Span Label Tag &~spii  &40¢>O— "%b{

Span Fibre Type E¢Aé"«wopiitmMoz«Ne | » O0>-R tb{

Span Lengthe pii®>0—"1b{ O~ e"0exz Span Measurements Unif$ Y " ¢ A
T' “Aetb{

EOL Ageing Factorr «Ne fwYz=> :rgb”"qVt—;b"<>O0—"1b{ \w
'tz E«»> IsM SOLipii @>»Zu~dtb{
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U i>C%E {

¢ «£ EOL Ageing Factorfhx EOL Ageing losswrj’T°Mt<«>O—"fb{tMw
NY"¢Atc>O—b"2AxK*“tdaoe{
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Connector loss [dBp piiw4 " “wBo a&>0—"1b{
CD factor [pm/nm/km]s «Ne TwpOii,¢ CDE »O—"tb{AN¥cAcxz~

R h«Ne | » Ot'loYs“tb{ \WNY”"¢cAtO—"hexz «Ne 1 »
O>1Eb”h|t« " ~etb{pDii,x%cz psinm/km UpO—"1tb{«N-
iwpOi,xzpO3-wa p [*e1b{ CliAx 15453 nmp [~ez L Ii

Ax 15904 nmp [t b{
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pO—"1b{

Length Based Loss - R hOuxz SpanlengtbuiiO£f *LossFactot e :£t'l
0«Ne T ®@U> "etb{\WWHE;«D¢«pu>~R sTIhOuxzuliw

i ®@>0—Db"ZAUK"“$b{

\W¥E «@B¢«pu> R sTIhOuxza”2 puiiwi a&>adb”"2AU

K“th{

Loss factor [dB/km]e E ¢ A& " «wopliiw @&@>-%b”’qVt—;b”"z0&éY"A

cp“w SOL«Ne 1 &2c>O—"1b{«Ne+ | & :xZcz dB/kmw UpO
— ¥b{
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Ne 1 &@>O0—"tb{ E«»> tsMi SOL &xz e :tO”>»Zu~d

h<ts“tb{ Length BasedP Agpxz\w<Ux"$t-% et b{

$ 2-18 Network Creation ¢Y2"Aw Site Parameters 0"~
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» O avy"» 7-0d"¢ 7-1 < AN¥cA« 7G/ < 7God"< 0°
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G.652-DStu  |pou, : @ 2.43 2.83 3.23 30 ps/nm/km
SNAE 1590.4 nme L 1TAE
PMD 0 0 0.1 0.5 10
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pA¢ O 1

>

HA¢O 2

pA¢s O 3

i»"NE | » O>=-R 1tb{

e Linee E"Ap4zb” 2Ew«Ne | 0z

e Terminale E"Ap4zb” 1Ew«Ne | Oz
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§"A¢CAU&" " 7.0-&"AE>eLb”"2AUK“tb{
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mw+ A w«RNe | 072¢°Mx006z<O°Mx!dEpIR*«0oMiEb{ NetView
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Cisco MetroPlannew 2z “iwAItmMoxz Ca A®GUI BCS“|3a"A8¢ A~ >€°
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|E+ Arca¢« tb{«Ne | piixz 2mwx A t7Oretb{\wx A
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t “oxz Cisco MetroPlannet) Eastq West>x~"$tD T f£b{
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HA(',O 2 AUTAwuoizx A)«&E&«‘ib{
pHAcO 3 AUIAW|E+ Arcae¢« tb{ Point to Point Demand CreatiohY 2” AU O "« t b
¢ $ 2-19f

HA ¢
HA ¢
HA ¢

(@}

(@)
&)]

(@)
(o2}

$ 2-19 Point to Point Demand Creation ¢VY2"A

General Parametersee Z2pz iw@ C>0O — "1 b{

+ Labels AUTAE>O—"1b{
+ Sources ¢ OW £06it AEU O7etb{
+ Destinatione ¢ Ow £|E+ AEU O~ etfhb{

+ Service Types AésO%ei a&pAT £"Tp » O>-Rtb{ +"Tpweatm
Moxz®126y+"ip +*U"A” ¢pl-4£>€° 0XirM{

e Present#ch "Rb"%“RE¢H>O—"tb{\WNY"cAtO—"h«pz Forecast #
chNY"¢cAUX "$tEyretb{
+ Forecast#ch ™MO«Ob"%REc:>O—"tb{\wctxz Present#chw<U e
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1+1zFiber Switchedzfhx Unprotected pb{-¢» OwAltmMoxz ®1.2.5y-¢M
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+ Pathe ¢f-¢wOUW £AEé;,O%ci @UAT ¢”AYi-

n Auto » “BREcwc"AYi-t "0z7GVWJIEQU '«fb{
Cisco MetroPlannexz wMyt)Q” pA>DOsv“7-vt 0z% REG¢g>
¢"AYi- tb{

M Ee+ 0dix Awf T'b,oWw%REC>¢"AYi-"$b{
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—pV" Ot £b{
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YBREcw4z+

» OWW%E«@¢«pP>-R 22T

pA¢ O 8 ClientInterfacena zpz SourceS‘| DestinationwAé¢s Ovi¢i s pAT z06iS‘|]|

Ew«d ZiA i»"NE » O¢ SRzIRzihx LRE> [Ttb{\w!O34ai
s—:pV'wxz0O4&4 O¢ «8 ZiA i»"NE p><«QhAATpUIYaS"|
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BREgUONth{
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$ 2-21 P-Ring Creation ¢Y2"A
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+ Service Types AésO%ei a&pAT £"Tp » O>-Rtb{ +"Tpweatm
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pA¢ O 5 Protection Sitesseezpz Ctrl >1°z P ai-tdChb"+ As«ae ¢« Fb{ Paei-tx
3mziw+ AUZApb{Eu'@»i>«ae¢« tb{eeuAtdC h+ A>_tb
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»Owg8aU¢ VE

8§40 40¢

°0

A/D Source

10ad¢ add/dropf %2REcwl:qs”+ AEU O7etb{

A/D Source Position

10a0O¢ add/dropE%2REcwl!:t0 b"&¢ «z3£¢NzS
‘|lué¢A  IDU Oretb{NY"¢cAw Ux Rack.Shelf.Slot
pb{

A/D Source Unit

1020 ¢ add/dropE %2 REgwl:qs”+"EU OMetb{

A/D Source Port

10a0¢adddropf 2 REcwl:qs”U”AU O~ «thb
¢ClientRX sr£ {

A/D Dst

10a0¢ add/dropf aREcw4:qs”+ AEU O”etb{

A/D Dst Position

10a0¢ add/dropE%REcw4:t0 b"8 ¢ «z3£¢NzS

‘|uHé¢A  ID U OMetb{NY"¢cAw Ux Rack.Shelf.Slot
pb{

A/D Dst Unit 10a0¢ add/dropf AREcw4:qs”a¥ IDU O7retb{

A/D Dst Port to0adc¢adddropE . REcw4:qs”U”AU O~ retb
¢Client TX sr£ {

Cl. Serv. Type AUiAw«d ZiA £’Tp » O¢ OC-48srfU O~ et
b{

Protection AUiAw-¢» O¢ P-ringz Y-cable srEU O "ot b

Wavelength «%BREcwpOU OMetb{

Opt Bypass TXPthx MXP §"Ap4z sMOUtz«%REGU :"e

06a0M"+"¢!OAYS¢ i ipe>6 %b{ Op Bypass
§4Ut® none U OrehOuzfw«%REGtx'OAYS
¢l IpU [*eoMFdee{

DWDM Interface Type

«¥BREGt—;b” DWDM i»"NE p » 0>0 %b{

« Transpondexz« % RE¢t MSTPA&TpUiYv%z MSTPU¢
«uUivizthx DWDM 0& O¢ U"A P a’¢s>—;

b"\q> " tb{
+ LineCardxz«%BEct ITU& i §"A>—:b"\gq>~
“tb{
DWDM Card Type «%REct—;b”"A&ipUivathx& i §"Aw» O>
O th{
pHAcO 3 y M«oae”>*"Rb”Ouxz [New Query] >«a ¢ « 0  Query Dialogt $ 2-28£> %0V t

b{ Query Dialog>—:b”qza [aY"»S‘'|ATO&"A>—;"0z«WRw>NY

¢c»aei-pVib{
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$ 2-28  Query Dialog

PALO 4 x‘WidY”»>—; o«oa">Teb"Oluxz Query Definitionase zwAé ¢ Ovacti
@UAT "pb”"l&Y”"»>-R tb{h@7<ew Query Previewa e 7t- R hi&
Y"»U Onetb{ ~ 2-14 pz Query Dialogwa NY"¢cAtmMot1 1 b{

2-14  Query Dialog wWNY"¢A

8§40 40¢ °0

Group AR ha¢”OwWA"»iZU f+"'0OtzeU"A>NYc»ei

-pVitb{ Project Explorerfa” wE ¢ A&" « N¥cYwqgl-p-
¢"0> Ob"\qpVib{

Demand R hAUTAwWA"»iZU ft+"*0tzeU"A>NYc¢»eei
-pVib{AUiA NY"¢cA>—;pV’wxz> wWAANY ¢« -
¢"0>-RhOuizZpb{

DWDM Card Type | -R"h DWDM §”"A » OwA”"»iZU t+"'0OtzeU”A>
NYc»ai-pVib{

Source > wl:x Agw WEO0+"TpuihxCox"IpwALiIZU
te" 0OtzeU"A>NYcgr»aei-pVib{

Destination > wihd:+x Agw WEOx"TpthxCoéx"TuwALiZU
te"*0OtzeU"A>NYcgraei-pVib{

Wavelength ' "hpO>—;b”+"TniZU ft«"*0tzeU”A>NYVYg¢
»aei-pVib{

Alarm ~@”iz né”z'e¢i"zthxe¢ ATOWNA-CVx"Tpi
ZU f$+"'0tzeU”A>NVYc»a@i-pVib{

P/F qOwzx"lTpuiZzeRwx"TpiZzthxtMU t+”'0tz
eU"A>NYc»ai-pVib{

Virtual Optical Results Tablg>Y % RE¢U t+"'Otzthx>Y%REC

Utzre"' OtzeU"A>NYe»ai-pVib{
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HA¢O 5 ZAt aoziwMceT>-R tb{

[Run Query] >«a ¢« fb{¢YiA¢tU az
Netbh ¢ $2-27E{B»T 1"wbY<z

* [ResetQuen} »«a&@ ¢« 02z

Traffic Matrix » Ot«nge”ALU O
+ o@ztcae"wiaY"»U " O"etb{
Query Dialogpw - R>«" " b{

[Closd >« ¢« 0z«age”>Ta sMptYiAc> atb{

pHA¢ O 6 Traffic Matrix eU”A> a”txz»OwERAw X>«ae« tb{

2.5.6yLayout w~ O

UsOAEsAé"«wax A>-&4NY ¢« Ob” gxziwqgS“pb{

=
>
-
(@)
'_\

NtView< E2 > »Or«aei« 0ze$ws A>«ca¢ « tb{

HA¢ O 2 Tasks Pang Layout >«ae¢ « tbh{ Layout»OU O”etb¢  $2-29£{+ A>!Eb”
txzAée OWuti @UAT &~s+ A>-R 1b{
$2-29 Layout @U"A¢d ¢« TA"E
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HA¢O 3 Site wAésOviti @pAT'zé Z¢A eU"At T Ob"E¢Aé"« + A>-R"
Fb{

HAcO 4 »0O( wAae” Ta’pz 8¢« E«a¢« 'z Expand>-R 0z &¢«°wb,ow3f
NS |8 A>0 haeph> O tb{

HAcO 5 &~sdi«thx3E£cNr«ae¢e« 0zé Z¢A -4NVY¢«q o O tb{ $ 2-30
tz3£¢N Ta">0 1b{
$2-30 Layout @U”A¢3E£¢N Ta"£

HA¢O 6 §"AwAI> Ob"txz§"A>%uOc«aes« th{«d 2iA@C>0 h Details

Yo 26-D ¢ «puU%ViEb{

+ Labels §"AEU O"efb{

e ProductIDe §”Awa¥% ID U O”etb{

e Service Category *Rw-—;

» Descriptions §”Aw;6tmMo osTiU O”e«tb{

+ Pricee Oé £«AMRIt-R hA " t,nMoz§"AwA U Oretb{
+ ITUChannels §"Aw ITU %REcpOU O etb{
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AdipUi%sS |U¢e«pUivs §"AtmMoxz Details¥% 2é-@¢«puw  Modules
+O»Os«a¢e«b’qz @ TXPIMXP ="t—:b" 04" O¢ U"A P 4"gU One
tb{
« PIFe PxqOw«& ZiA AUiA>+U"Ab"04&4" 0O¢ U'A b a’¢>"
tb{ Fx*Rw«d ZiA AUiA>+xU"Ab"0&" Og¢ U"A P a"¢>
th{
+ ModulePIDs 04" 0¢ U"A bP a"cwa¥% IDU O”etb{
« Ch#t+ ="wU"AjgU 0r+z04"O¢ U"A P a’cw “CZ+"U! A
«1b{

[Closd »«ee ¢« 0z Details¥ 2é-D¢ «u> atb{

pA,O 7 & 2¢A 0>NYg»ai-b txz Aéo,O0%ei sepuAT iwMceT 1m>=R"’
Fb{
« Any » qOS‘|*RWIMWAANY ¢ « AUiAt Eb"8"AUb,0 OAet
b{

+ Presentt qOWAANY¢s« AUiTAt Eb”8"AiZU O etb{

o Locked & Unlockeds & Z7CA°pé¢s«reoM”"8"AS |é¢«rtheoM”
§"AUSD Oretb{

o Alarmeds & 2¢A°pz&"UwK”"8§"AUSD O~ etb{

HA; O 8 E¢Aé"«lis™xzb,owz AUUEé¢ « P"Ats“tb{§"Awé¢wrrt z
E¢cAé «rsitz Cisco MetroPlannetJ & 2¢A>6DT ozué¢s Aw—;U78&="
" Oth"txza¢ « Ae’"péi«reoM"8"AsEwam¢ « z Unlock >=R"
Fb{
C«E éi«ortpViwxz DesignpA” Aw UpgradeE ¢ A&” «tv’etb{
HA;O 9 @& Z¢Aw-aNVYs« 0> JPEGN¥"U¢Apo«pU”Ab"txz [Export] >« & ¢

« tb{ Layoutexport¥s 7é-@¢ «putzNe cE>O—"z&~sN¥c¢c¥t ~
b{ [Savd >«ee ¢ « Th{

HAO 10 ¢ 2¢A  -8NY¢i«w>V—-thx!Gb"txz ZoomInz “iS‘| Zoom Out? i
>fegewae « Tb{ Cisco MetroPlannew 7z “iwAltmMoxz Ca A®GUI @CS
3a"AS AT »E° 0 XiAM{

pA¢s O 11 LayoutéU”A> a’txz»OwERwW X >«aee« th{

25.7yLayout eU"AT'w«...?2—w O
+ Aow+"]qt«...?—>"0Ob” gxziwgS“pb{«..?—xz Layout e U” A
T'@U”A Up-YpVib{
pA(,(') 1 NtView< E2 > »0>«aei« 0ze$wt A>«wa¢« tb{

HA¢ O 2 Tasks Pang Layout >«ae ¢ « th{ Layout»OU O”etb¢  $2-29£{+ A>!Eb”
txzAée Ovuti @UAT &~s+ A>-R 1b{
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(@}

eU"Aw 0

eU”A A’c¢l”w  View layout as tablez

Oretbe¢ $ 2-31F

$231 «.?—

T 215pzagadlUw@CtmMoti tb{

Layout Table ¢«...? —£w8§4U

Tir«ae e« Eb{ Layout Tablee U” AU~

— 2-15

§aU alg¢ °0

Name + Aw;+U O”etb{

Position “pb+"wa¢«z3EcNzthxpégAs"UON
“1b{

Description a+"» OwtiU Oretb{

Max Power Consumption (W)

B+"W7G«...?—U O"etb{

C«E

U"A P a’¢>+< hA&ipUi
§"AwOuz Ore"7G«...
U"A b a"¢gr=+«

0a"0¢
Yl Ug «pUiYs
?—xz7G:w04&"0O¢
"hNceL@”Aw<pb{

C«E

Average Power Consumption (W) "pb”"+"w E«..?2—U O7retb{

U"A P a’¢>+< hA&ipUi
§"AwdOuz “O7e” Ex...
U"A b a"¢gr=+«

0a"0¢
Yl Ug «pUiYs
?—xz7G:w04a"0O¢
"hNceL@”Aw<pb{
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HA¢O 4 «..?—wWA”»>o«uU”Ab"txz [Export] >« ¢« tb{  Layouttable exports z
€-D¢«pulU ONetb{Ne ¢cE>O—"2z&~sN¥c¢¥t "~ fb{ [Savd > «
®¢« $b{

HA¢O 5 [Closd >« ¢ « 0 LayoutTablee U”A> atb{

2.5.8y Link Availability eU”"Aw~ 0

Cisco MetroPlannex z+ ", EpS*‘|.gl t,nMozaei«wzd &iaeAY>Q.."
tb{ Link Availability e U”A>"0Ob” gxziwgqS“pb{

pHA¢O 1 TwMceTw g>fae thb{

e E¢A&"«w Link Availability eU”A>"Ob"txz Networks Mgmt Tree » O >« & ¢,
«ZMNIEG A8 o« « b
« = Aw Link Availability eU”A>"Ob”txz NtView < E2 > »Os«ae ¢« 2N’

t+ A)«&d«‘ib{

HA¢ O 2 Tasks Pang Link Availability >«a ¢ « tb{ Link Availability »OU " O7etb¢ $ 2-32f{

$ 2-32  Link Availability &U”A
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(@)
N

eU"Aw 0

»Owoé"xz

«TwiR¥"Uip>0 %b{

T 216pz8aUw@CtmMoti £b{

~ 216  Link Availabilty »Ow8§aU

§a4U a0¢ °0

Group aAUTA » OUUG"~+tbe¢U TAA”U iAz P e
i-2S‘] ROADMEAUTA » Ow#wOAaut +£Gg
@« 02%  Z«HBREG> O Fb{

Serv.Circuit «%RBREcwaDc¢ Sitel-Site2sr£U O”etb{

P/F BREcUQqOS‘|*R¢ PFEswT*R¢ FE£swT>0"
th{

DWDM Card Type «VBREct—;b”AdipuUivathx& i §"Aw»
050 1tb{

Protection AUiAw-¢» O¢ P-ringz Y-cable srEU O et b

Cl. Serv. Type AUiAw«d ZiA +"Tp » O¢ 0OC-48sreEU O~
etb{

Source «%BREcwl:qs”"+ AEU O7etb{

Destination «%BREcw4:qs"+ AEU ONetb{

Link Availability (% Complete)

ei« 720 &lee AYWAUU Oretb{ ®ei« 720 &

leeAYxz,EpS‘|.gl t,nMo% Z"«tb{

[New Query] >«a ¢ « 0
[AY"»>—;"0zeei«

X‘WIAY"»>— "o«oae”>Taeb”"Olxz
@UAT "pb"iaY"»>-R tb{h@7<ew
Y”))U_C)A'ib{

Query Dialog> % VEb¢ $ 2-28£{ Query Dialog>—;b"qzo
70 &laeAY>NYg»ai-pVib{

Query Definitionaae zwAé ¢ O%¢i
Query Previewa & ?2t-R hia
T 2-17 pz Query Dialogwae NY”"¢cAtmMoti tb{

2-17 Query Dialog WNY"¢A
§a4U a0¢ °0
Group AR ha¢”OwWA"»iZU f+"'0OtzeU"A>NYc»ei
- pVib{ Project Explorerfa”wE ¢ ;A&" « N¥¢cYwqgl-p-
¢"0> Ob"\qpVib{
Demand R hAUTAwWA"»iZU ft+"*0tzeU"A>NYc»eei

-pVib{AUiA NY"¢cA>—;pV’wxz> wWAANY ¢« -
¢"0>-RhOuizZpb{

DWDM Card Type

-Rh DWDM §"A » OwA”"»izZU f+"*OtzeU"A>
NYc»ai-pVib{

Source > wl:x Agw WEO+"TuthxCo+x"TpwALiIZU
te" OtzeU"A>NYgr»aei-pVib{

Destination > wihd:x Agw WEOx"TpthxCoéx"TuwALiZU
te" OtzeU"A>NYcgr»ai-pVib{

Wavelength ' "hpO>—;b”+"TniZU ft«"*0tzeU”A>NYVYg¢
»aei-pVib{

P/F qOwz"lTpuiZzeRwx"TpiZzthxtMU t+”'0tz

eU"A>NYe»ai-pVib{
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HA¢O 5 ZAt aoziwMceT>-R tb{

« [RunQuery] r«xa ¢« fb{¢YiA¢cU az Link Availability » Ot«oa”ALU™
Oretb{D»i i"wbY<z+ oeezt«oa”’widY"»U O etb{

* [ResetQuen} >«ee ¢« 0z QueryDialogpw-R>«""b{
e [Closd »«ae¢« 0z«ag”>Ta sMptYiAce> atb{

pA¢ O 6 Link Availability @ U”A> a”txz»OwWEfw X r«aee« th{

2.5.9y Optical Results w0
ARS‘|Us hE¢Aé"«w«Rw> Ob” qxziwgS“pb{

pHA¢O 1 fwMceTw g>fae thb{

e E¢A&"«w Optical Resultse U”A> " Ob"txz Networks Mgmt Tree » O > « & ¢ «
CZMtEAET o w@me « Db

« + Aw Optical Resultst U”A>"Ob”"txz NtView< E2 > »O>«ae ¢« zM't
+ A)«&d«\ib{

HA ¢ O 2 Tasks Pang Optical Reslts > «ae ¢ « “tb{  Optical Results» OU " O~efb¢  $ 2-33£{

$ 2-33  Optical Results » O
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»Owoé"xz

«TwiR¥"Uip>0 %b{

T 218pz8aUw@CtmMoti £b{

T 2-18 Optical Results »Ow8§aU

§a4U a0¢ °0

Name BREgUf-tO—~"rehqtzaiptx"$tA“po’shY
jgU Oretb{

Group «BBREGWAUITA -¢"OU O~ etb{

Protect BREgw-¢» OU O7retb{-¢%REcwOUZzZTMwWI
HU Oretb{l:wf T'Z"IHUEtO"etDb{

soL e hisALWAYU  StartofLife«Ne | a<q 0 O~
etb{ i"-"»xzOM?2 Optical Chanel Trait OCH TrailE w M
2]qtz«wiN¥"Uiu>0 tb{-a&”ixR-z né”
X¥ Eeoep«t 0 ™16%E>™ “fb{!ei x%BRECGE.
Waepn«UOME 16 ™M50%E\q> "ze ¢ AxEe> " 1b{

EOL fee hisALWAYU EndofLife«Ne 1 s2<q 0 O~"e
tb{ 1"-"»xzOM?2 Optical Chanel Trait OCH TrailE w M 2
Jgtz«wiR¥"Uip>0 tb{ i"-"»xz«Ne |
wHET:pwipw«IN¥"Uip>0 tb{-a®”ixR-z
né"x¥, Ecmp«t 0 ™M16%E>™ T th{lei x¥%R
EcEewaeu«UOME 16 ™50%£\q> " z&¢AxEe>
tb{

SE f-wiistel>)Q"DOQwK”"z3uAU Erd”w O>

O $b{

\w i -"»UeiAwOuxzisw7 ™MteU"ArehY
7 aY 0zdJwK?+"thx: As> “ToXitM{

Chr. Disp. [ps/nm]

pbOU,U*wW<U Oretb{-ae"ixzpOu,U*tu"
hig>™ " tb{e¢AxzpOiu,U*tAEu"ilh\g>™
—ib{

Penalty a NY¢g» » O¢ OADMzROADM z S ‘| Arrayed Wavelength
Graging [AWGJEU<h’ " h O £¢cAYwW<«S* |[pA”"»pU 0O~
etb{ -@"ixz OECAY BEL«tu  hig>™ " th{
e AxzOECAY WEL«tAEU ilh\g>™ " tb{
Wavelength «itA“po’ehpOUOMetb{
P/F qO/*Rwz"Tpu Opb{
Source l:+ AES‘|z AUTO7«tb¢ Site 1-Esr£ {
Destination 4:+ AES‘|x AUTO7+ftb¢ Site 1-Esr£ {
Span (km) \WipwipiiGel:T'4:£UO©éY "Agoep ONe
tb{
Tx Type > W OCHTrallt—;b” DWDM +"3hx0& Og¢ U'A P
“a"cw» OUTONetb{
BER target \W¥»RBEcw« i»”"NEf pwoé—t,nMoz%REcUE?

gb” BER¢CT¢A ad8” @”"AE£UO~etb{ Forward Error
Correction¢ FEC; 2Mad” Y£>—;b” i»"NE pwouU
X 1.0E-152FEC>—; sM i»"N£ upx 1.0E-12pb{

SOL OSNR (dB)

#Ew7swl:pwzeés3"|"tSz” E Optical Signal-to-Noise
Ratiot OSNR; « 6 g0Vv;zEU O"etb{ OSNR xz-R”"eh
Resolution Bandwidtlt RBW; Gir63-1£> " $b/{
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EOL OSNR (dB) HEW7 ™Mwl:pwes3"i"tSz” E OSNR <U O~et
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SOL Overload (dB)
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TTU"ETAU tetfb{ ®i«T.w PMDU+07Gc>isl
hOuxz PMD <U&¢Ap ONetb{07Gcxz«d Zi
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Latency qgOwstw— 1 U O7retb{\wctxzipiw«Ne
1S DWDM +"> Sz OCHTralwb,ow— TU"ETA
U fefb{
pA¢eO 3 [NewQuerny >«a¢ « 0  Query Dialog> %0 Vib¢ $ 2-28£{ Query Dialog>—;b”"qza
[&Y"»>—;0z«WRW>NY¢»ai-pVib{
pPAcO 4 x‘WidY"»>—;'o«ma”>Teb"Ouxz Query Definitonaee ZwAé ¢ OVt i

@ PUAT "pb”l4dY”"»
Y”»U Oretb{

>R tb{h@7<aw Query Previewo ee 7t- R hi&
T 2-19 pz Query Dialogwa N Y "¢cAtmMoti tb{
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Group “Rh-¢”"OWA”"»iZU f+"*0tzeU”A>NY¢»
®&i1-pVib{ ProjectExploreia”wE ;A& « N¥c¥awq)\
—pﬂg”0>_0b”\q<pvib{

Demand “RhAUTAwWA"»iZU t+"*OtzeU"A>NY¢c»
@i-pVib{AUiA NY"cA>—;pV"wxz> wA&
NY¢« =¢”0>=-RhOuizZpb{

DWDM Card Type -Rh DWDM §”"A » OwA”"»iZU t"*OtzeU”
A>NYg»aei-pVib{

Source > wlh:t Agw WEOG+"TuthxCoéx"TuwALiZ
U f+"'0tzeU"A>NY¢c»ai-pVib{

Destination > wa:x Agw WEG"TuihxCox"IpwALiZ
U f+"'0tzeU"A>NY¢c»ai-pVib{

Wavelength ' "hpOs>—;b"+£"TpizZU $«"*0OtzeU”A>
NYc»ai-pVib{

Alarm ~@e”iz mé”zléi"zthxe,ATOwNa-cv"l
HiZU f+"OtzeU"A>NY¢»ai-pVib{

PIF qOw+"TpiZzeRwW+"THiZzihxtMU f"*0
tzeU"A>NVYcr»aei-pVib{

Virtual Optical Results Tablea>Y % RE¢U F+"*Otzthx>Y%RB
EcUtZre" 0OtzeéU"A>NY¢»aei-pVib{

pAcO 5 ZAt aoziwMceT>-R $b{
+ [RunQuery] r«a ¢« tb{¢YiA¢U az Optical Results» Ot«ma”ALU O
Netb{@»i i"wbY<z+ onaezt«na”widY"»U O7retb{
* [ResetQuen} »«a¢ « 0z Query Dialogpw-R>«""fb{
e [Closd >«ae¢« 0z«ma”>Tae sMpetYiAe> atb{
pA¢s O 6 Optical Resultst U”A> a”txz» OWERwW X >«aee« th{

2.5.10 y Wavelength Routing w~0
USOAE Ae"«wpOc"AYin UeO> Ob” gxziwgS“pb{
HA¢ O 1 Networks Mgmt Tree » O>«ae ¢ « zUsb"E¢Aé " «r«ae¢ « Th{

pA¢ O 2 Tasks Pang Wavelength Routing > «a ¢ « “+b{  Wavelentgh Routings OU " O~etb¢  $
2-34£{0 4 AN¥"0U+xU"Ab"pO]qt laecm Oretb{

¢t«<£ ROADM ¢ Any-to-AnyEAUTAxz\weU”Atx fefdee{
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$ 2-34  Wavelength Routing  » O

HAcO 3 Aés0%eti apAT’'z Any¢*RqqOwtMwc”AYi-> Ob"OuUE zPresentt q
Owc"AYi-iz> " Ob"Oufzthx Forecastt *Rw¢”AYi-iz>"0Ob"0
UEWMcsT 1m>-R tb{ Any>-R hOuz ForecastAUiAx-&"sp One
fb{

T 220pzagdUwg@CtmMoti tb{

2-20 Wavelength Routing »Ow84&U

§40 &40¢ PO

wi O&acAN¥"UU+U"Ab"pOU Oretb{

Site # E¢Aé"«owx Apb{ Site §8aUwixz+x Awfegew w
SOL/EOL % REG pA"»u> "tb{-a&"ixR-z 0é"x¥,
Eemp«t 0 ™M16%E>™ " th{!ei " x%REcEswaepu«Ub
M¢16 ™M50%E\q> "z& ¢ AxEe«> " fb{

Duct # E¢Ae"«ow¥«Apb{

W + Awb >™ " fb{

E + Awf >™ " fb{

Couple + Aw«Ne | O0z>1b{
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C«E

\weU”ApxzA”¢wliAUb;pVib{ Site §4Ut§"1¢>"Xqzs¢
@Cz8"AEzS'|a¥ IDU" «+b{ Duct/Couple§aUt§"1¢>"Xqz
220725 |«Ne Tw» OU™ «$b{

HA;O 4 & 2¢Aw-8NY¢« 0> JPEGN¥"U ¢ Apo«pU”Ab”"txz [Export] >«ae ¢
« tb{ Wavelength Routing expofts 2é-@ ¢ «ptzNe ¢E>O—"z&~sN¥c¥
t " ib{ [Savd >«a ¢ « b

pA¢ O 5 Wavelength Routingg U”A> a”txz¢YiACEiw X r«aeé« Th{

2511yeU”Awigw 0

2 mwE¢Aé"«p BoM @U”Az Internal Connection®@ U”AzS"| Installation Parameters
eU"A>z+pVib{\exz,jE¢;AE"«q

Install + hx UpgradeE ¢ Aé” « wi
§>-Yb"Out(bpb{

« BoMDiff eU"Atxz

BoM t0 08Cthx_treh+"U O7etb{
Internal Connection Diffe U” Atxz!E~eh€ U OMetb{°®€ w 2 mwai
AU iAwOjz—sXqc« 1mUYsloM”Ouz Cisco MetroPlannex®ae € U!
Ereh\g>eU”A tb{eU”Atxz,JE,Aé"«t O'oMo0z74E,
Aé”«txsMb,ow®e€ zS'|,JE¢Aé"«tx O sMUT74E¢ A

g”«tx O"oM”b,ow°a&€ UO"etDb{

Installation Parameters Dit U”Atxz ,jE¢Aé"«q74E,Aé"« p!E~eh
iéY"»U_O"'ib{

EcAé”«>zxb” qxziwgS“pb{
pHA¢ O 1 Reports Diff 7 “i>«a¢ « ftb{ Cisco MetroPlannerz “iwAltmMoxz Ca A
®GUI GCS*'|3a"A8¢ A~ >E€E° 0 XiM"M{

Report Diff ¥4 2é-@ ¢ «pU O~
efb{ $235tz0é E£«AtisOAWE;A&"«U 2mZik”Ouw Reports Diff %
iéﬂ@d«“W«)é‘ib{
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$ 2-35 Reports Diff Y4 Z2é-D ¢«

=
>
-
(@)
N

Compare networkstee 2pz( wWAé ¢ Ovci @pAT JEcAE"«>-R Tb{E
wAé,0wuei @uAT zz+b’E A&"«>-R 1b{

=
>
-
(@)
w

“Ob"eU"As«ai« Th{is0OAZWE A& "«>-R hOuz OpV”wx
Bill of Material wig§>O heU”AiZpb{

* Bill of Material *

¢ $2-36£8a0UwtitmMoxz T 2-21>€° o XiMNM{
Installation Parameters ¢ $ 2-37£884UwtitmMoxz

Internal Connections ¢ $ 2-38£8&4UwtitmMoxz

T 2:22>€° 0XiAM{

T 2-23>€° o XiM"M{
HA(',O 4 [Ok] »«ae¢« th{

$ 2-36tz BoMDiff eU"A>0 tb{

$2-36 BoMDiff @U”A
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BoM Diff Report » Owliae - «38itzE, Aé"«]qtiw@CU O etb{

+ BoM total discountece BoMt f«"2 AU]qtz CubzeVu>tXEELAE «
.WA“U O~retb{ Useglobal discounb - R h O 0 xz Global discount percentage
NY"¢cAwA“%VUU-t fetb{

+ Spare total discountedd E ¢, Aé”«f.tmMozb,owYiAEipu ‘i»wb,ow
*UOZ@Yatipb”"A U Oretb{\exzA“%UVA >—; hzopOz
7 AUwu-pb{i-U"07re"wxz Spare Part Repofs £ ¢ « D ¢ « >R 0T
"pb{

+ BoM + Spare total discounted BoM wi-A“% VA quOZwiu-A“% VA" > 0% "
h«cU OMetb{

o PriceListe Oé £«A;t-R hA""A"»0"uwE2U O"etb{

+ Currencys ~RhA""A"»0"up! "soM”zoA"we_U O7etb{

~ 221 pz BoM Diff e U"AtSZ"a§a0Uw@CtmMoti tb{§aUs>«ae¢«b
"qzfw§aUt,nMo W@CU ,8Q +1hb{

2-21 BoMDiff eU”AwS§A4U

§a4U a0¢ °0
Name + AS‘|+"wWE2U O7efb{
(Diff Summary) 2mwE¢ Aé"«w BoM tig§UK”"\gq>O tb{

=¢s@f « 2mWE AE"« ti§UsSM\g>™ " 1hb{

¢'j«rehsg£E « fwz AUXTMWE;AE"«t O
"OM"UzE¢ Aé «]qt:UY¥s"\g>™ " fb{

1+ \wz AUU7swEs Aé"«tKloz 2 SWE¢Ae”
«txsM\g>™ " fb{

2« \wz AUU 2jSwE¢Aé"«tKloz7swE¢Ag”
«txsM\g>™ " fb{

PID av%awID E»U " O”etb{ PID> Ob"txz+"Ew#wO
AUC +£G@>«a« 02%  Fb{

Quantity BoMtSZ”"> wa¥%w:"U O7retb{E; A"« p:”
UYs”Ouz CiscoMetroPlannexiw UpztMw<«éeAp™
O tb{

7SWE;AE «w:” 12 jJSWELAE «w:”

Unit Price a+"WA U O”etb{+"A"> Ob txz+"Ew#w

O8ut +£G@r«a« 02%  Th{

Total Price A“%uVve&.2wza%wl-A"U Oretbh{E¢A&"« p
"UY¥s"Ouz Cisco MetroPlannexiw UpztMwo e g A
PO tb{

7SWEZAE «wu-A" 12 jSWESAE «wu-A"
Discounted Total Price |A“%V&; ™Mwza%wiu-A"U O”retb{E, A& "« p
:"UYs"Ouz  CiscoMetroPlannexiw UpztMwoeg A

p O tb{
TSWEGAE «WA SV ™Mwa-A" 2 jSWE;AE"«wA
“GVMwO-A"
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$ 2-37 tz Installation Parameters Di¢ U” A>O "1 b {

$ 2-37 Installation Parameters Diff & U”A

T 2-22 p z Installation Parameters Dit U”Aw8§4UtmMoti $b{884U>«a¢«b
"qzfwg8adUt,nMo wW@CU ,8Q'+1tb{

EcAé"« wixiw Us—;"oze¢cAp Onretb{
JECAE «w< | 74E;Aé 7 «w<

T 2-22 Installation Parameters Diff eU”Awg§aU

§A° o
Name + AEUO7etb{
(Diff Summary) 2mwEgAé"«w BoM tis§UK”"\gq>O tb{

=¢s@f « 2mWE AE"« ti§UsSM\g>™ " 1hb{

¢'j«nrehsg£ « fwz AUXTMWE;Aé"«t O
"OM"UZE A8 «]qt:UYs”\g>™ " fb{
1+ \wz AUU7swEs Aé"«tKloz 2 SWE¢Ae”
«txsM\g>™ " fb{
2« \wz AUU 2jSwE¢Aé"«tKloz7swE¢Ag&”
«txsM\g>™ " fb{

Side E"A i»"’NE pU O”etb{ T¢4zE£ zECTE zthx W
¢ChEpPD(

Position l¢% "Awl:qs”8"Awd ¢ «z3£¢NzS |ué¢ A
«"UTONeEDb]

Unit §"AEU O7etb{

Port # i¢% "Awl:qs"U"AjgU " O"etb{

Port ID U’A ID U O”etb{
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T 2-22 Installation Parameters Diff eU”Aw8§aU¢ VE

§A° @ 0]

Port Label U"AEU O7ethb{

Parameter RX Power Lo®rzf "*oM”"i&AY"»EU O~"etb{

Value f "eoM”<wWE2U OMeth{

Measurement Unit dBnsrz Eb” TuA”g [aY”»<«w- 0eU ONet
b{

Manual Set CTC i»"NE po—:"0 "plaY"»>f b"2AQ
w AUO”MNetDb{

$ 2-26 tz Internal Connections Diffe U”A>O 1 b{

$ 2-38 Internal Connection Diff eU"A

~ 2-23tz Internal Connections Difte U”Aw88US'[°0>0 " tb{84Us«eae ¢ «b
"qzfwg8aUt,nMo wW@CU ,8Q *Fb{

EcAé"« wiSxiw Us>—;"oze¢cAp Onretb{

JECAE  «w< | 74E;Aé7«we
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2-23 Internal Connections »Ow§4aU

§4UE 0

Name + AEU O7etb{ SW provisioning viewt O» O pxz\w § &
Ux CTC i»”"NE p>—;"0€ > "pf thx_*1b
"TrOoT>0 1b{

(Diff Summary) 2mwE Aé"«w BoM ti§UK”"\g>O tb{

=Csgf « 2mMWE;A&"« ti8UsM\g>™ " fb{
¢'j«rehsg£E o fwz AUXTMWE;AE"«t O

"OM"UZE A8 «]qt:UYs”\g>™ " fb{

1« \w? AUU7swE¢;Aé"«tKloz 2 SwWE¢Ae”

«txsM\g>™ " fb{

2« \wz AUU 2jSwWE¢Aé"«tKloz7swE¢Ag”

«txsM\g>™ " fb{

Position i¢% "Awl:qs”8"Awac«z3E¢gNzS |ué¢ A
U ONetb{
Unit §"AEU Onetb{
Port label U"AEU O7etb{
Attenuator ' reoM”OuUxz \WE€ t+che”lgcanO+wavs ID p

b{Oa@ziOw DC-TXS‘| DC-RXU"A t°en0+>f""
sZeys'sMOuU¢ DCU>+< sMOUELt«C "etb{

Position l¢% "Awa:qs"8"Awd¢«z3£¢NzS |puée A
«"UTOMtb

Unit §"AEUONetb{

Port Label U"AEU O7etb{

P/F € UqO¢ PIFEws¢t Eb”"wTz*R¢ FEws¢t Eb”
WTUOAeth{
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26y0é £«Aw$B

Cisco MetroPlannes —; b " qzE ¢ Aé" «lisw2™rj'p«zOé £«A>$BpVH
b{E¢Aé"«lisatC\ hed” Yé-""xz 1mZiwE¢iAé "« TTUTETA
>$B ' SMTW “zr«resM\qU ‘XK“$b{

Wptib”a g>leeb”txzO0&é £«A>%VZE;AE"«>€é”A 0SXZA
UK“tb{ ®2.11y0é £«Aw% VM~ ¢p2-3ES‘| ®212yE;Ae"«wé”"AS"|
2ié"A™ ¢p24£5€° 0XirM{

26.1y0é £«A [aY"»w$B
Oé £«A T&Y"»>$Bb” qxziwgS“pb{

pA¢ O 1 Project Explorerp [Project] >« & ¢ « Fb{

pA ¢ O 2 PropertiesO 1tzZAs@C>0O—"1tb{

+ Costomers \WE ¢ A& "«f->A{"oM"§u»U"WE2>0—"1%b ¢7G 128
E £{

+ Createdbys 4"2E¢7G 128 E£>0—"1b{

e Unitse piiw- oeU O7retb{ KmetO©éVY"AcEthx Miles p b {

o PriceListe Aé¢Owuei @pAT AA"»O"p>=-R 1Db{

o Layoute O&¢cAN¥"U » O>7b ANSI¢z WF " £3hx ETSI¢C MF E£U"
Oretb{ ANSIE;A&”«wOuxz SDHCETSIEx"Ip AUiA> [pVidae({
ETSIE¢Aé”«wOuxz SONETCANSIE+"Tu  AUITA> [pVide{

262yE¢Aé"«  [&Y"»w$B
EcAé”« [&Y"»>$Bb” gqxziwgS“pb{

pA ¢ O 1 Project Explorerf hx Networks Mgmt TreepE ¢ A&” «>«ae ¢ « $b{
pA¢ O 2 PropertiesO itzZAs@C>0—"1b{

« Names E A&"«E>O—"1b¢7G 128 E£ {

+ Positions 'O £«Awe">P«-¢pO—"1b{

+ Createdbys 4"2E¢7G 128 E£>0—"1b{

+ Statuse E¢Aé"«wY6¢ Designz Design-Analyzed Install sTEU O et b{

+ Use MSM Buldless BoM wARItz x‘wZ AUpxsXz Multishelf Management Integrated
Kit 1TA¢>—;b”Out-R tb{

+ UseSpareParts E,Aé"«tzAspOza@%>Q b"Out-R tb{E; Ae&”
«U Upgradep A" AwOuzi+b"+"TpS*|y " X&aCrehqOw="Tp>+
U"Ab"hStzAse¥%U ftetb{uOzawuweéU"A>"Rb"txzE¢ A

87 «lisw2tz EcAé"«ow+ AqYiAEip ‘i»>0 CZ"ZAUK"“%
b{
+ Use Global Discount E¢Aé”"«f.t-é"i¢ AYpgciA>&:;b"Out-R"

th{-é"l¢ AYug8¢iAxz BoM wb,ow TU"EiAt&;"e$b{
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+ Global Discounts y M-é"i¢ AYusceiA>i”-iApO—"1fb{

+ ServiceLevele AésO%¢i apAT 27Ip edct YyEWY >-Rib{

+ Service Lengthr AéoO0%c¢i s pAT YIAETN +'Tp eOcwONC&: £
R 1b{

 Include SW Licenses BoM t:NA¢E 7 & -ip> S"0Out-R fb{

+ Include Paper Documentation BoM ti1n UwUCaz¢> S"Out-R $b{

+ Include CD Documentatiom BoMt CD UwUCaz¢> S"Out-R fb{

+ Hide Bom/price discount BoM w Unit Price §4Ut-é"l¢ AYugciA> 0 sM
Gut-R tb{

« Dimensions E¢Aé"« + [>P«-coepO—"1b{

« Background color E¢Aé”«w i>-Rb"Olt«ae¢« tb{

+ Background image “pb”Ouz g o-;b” JPEGthx GIF Ne ¢wE2U"
Onretb{E¢A&"«w -4&4NY¢«q o JPEGthx GIFNs ¢>-Rb”0
Uxz<2Vwil>«a¢« z&~sAYe«Aeset " “1b{

263y+ A [aY"»w$B

+ A [4&Y"»>$Bb”qzgOw+ AIR>IEpVEDb{ Project Explorerw + A N ¥
¢tz i»"NE p E"A@CU OretDb{ $239tzE; A& «lis2w Project
ExplorertSz"+ A>O fhb{ $2-40tzE¢ Aé"«lis™w Project Explorert SZ " +
A>O tb{

$ 2-39  Project Explorer tSZ*+ A
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$ 2-40 Project Explorer tSZ*iis™wzx A

Us™MwWE¢sA8"«f->"bx A N¥c¥%txziwz AU« fezfw XU$BD
6pb{

I+

EzWzT « Line thx Line+ + AwOuz Project Explorerw Site N¥¢cY%w<tz WG¢WestE
S‘| E¢EasttqMO&Oc¢w i»"NE p E"AU 2m O7retb{ Terminalfh
x Terminal++ AwOuz O"e”wx 1mw i»"NE p E"A¢ TEiZpb{

C-Bandthx L-Bands + A¢ EzWzthx T i»"NE pEpzU”Are"1i
AUuTO07etb{

Amplifiers « ciiAS‘|o+ A¢ EzWzthx T i»"NEf pEwyi+S*|
b,ow E§"AUO"etb{
Add/Drop s 1TAS'|+ A¢ EzWzthx T i»"N£ pEwitoade add/dropE

S| E§"AUD,0 Oretb{
Site Type Parameters ~Rb”qz PropertiesO itx Aw:6S‘|» OU O~"«t
b{

Band Parameters ~Rb”qz Properties® itZ—U O7efb{
Clieth» «8 ZiA §"AUONetDb{
A TaY”’»>$Bb” gxziwgqS“pb{+ A>_tb"txz ®2.6.4y+ Aw

1T ¢p.2-76E >E° 0 XiAM{
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pA¢ O 1
pA¢ O 2
pAes O 3

26y0é6 E«AwSB ||

Project ExplorepzE¢ A&"«  N¥¢UnEwae« 22a"A§¢A VGa'T' Expand
>m R fb{

&~s* A N¥c¢¥«a¢« $b{ Properties® it+ A [AaY"»U ONetb{

7At aoiw@C>0O—"z PropertiesO iwz+ A [AY”"»>1E tb{

Namee &~s+ AE>O—"1fb{

Positons “pb”"+ Awb«-¢c*">O—"1tb{hqQyz NtView< E2 > » Ow/(

it Sitez "i> "b’Ouxz 00>0—"1tb{

Structuree Aé¢;Owe¢i @apAT'T » O>-R 1b{

U Linee E"Ap4dzb” 2Ew«Ne 1 0z

p Terminale E”Ap4zb” 1Ew«Ne i Oz

B Linet e« 2 Ew«Ne | OZUE”Ap4z tbUz MMU §”"A¢AUé 7é
O-e"Af>eLb’qz«Ne Twi>yedib{\wE"At MMU >elLb
"qgzMmp<\WE"A>Uc%AY-a" E"At!ApVib{

p Terminal+ s 1 Ew«Ne | OzUE"Ap4z tbUz MMU §"A¢AUé "
7260-&"Af>elLb’qz«Ne Tw:>yedib{\WE"At MMU »>e
Lb”gzMmp<\WE"A>Uc®%AY-a&” E"At!ApVib{

fwli TEUDOpb{

i Line T’ Line+
B Line+ T’ Line
i Terminal T* Terminal+

i Terminal+ T’ Terminal

fw wi 1E¢ Line T' Terminalsw!Esrf£>a200uxz+ A> t z~So
ACb"ZAUK*“1tb{

MTTR¢hoursEe E¢Aé"«wb,ow+x AtmMoz Mean Time To Repait MTTR; E
gl £50—"Fb{\exE¢ A& «wWK’e"+ At&;"eftb{+x Aw"

R ™ zMTTR <>!E\hOUzy\M(U&;"'"WXZ!ETMt"R\hi Aizt

Suib{

Maintenance Centesr Aé;, Ov¢i e pAT YIAETN Ci»E>-aRtb{YiA
Eip -i»>*"Rb"0Ouxz ®2.65yYIAETH -i»WAR™  ¢p2-77£5€° 0X
iAM {

IP Addresse E”Aw IPZAep>O—"1b{

Shelf Confige Aé¢O%¢i @uAT'3£¢NIRw» O>-R tb{

I Multi Shelf Integrated Switch Multi Service Transport PlatforeMSTP£« §”A¢  OADM S
‘|yi+£xb,0z LAN t‘10€ AehzfegeVs"3£¢RNt "Aet
b{ LAN x MSTP3£¢RNt€ Aehp ¢%pi+retb{\w!O%4&i>-R
b” gz Multi-Shelf Integrated Switch CatiMS-ISCE£>—; oU¢%3£¢NIR U

U Aneth(

U Multi Shelf External Switche b,ow MSTP «§”A¢ OADM S'|yi+£xz LAN p
€ MehfegeVs"3E£gNt "Aetb] LAN x MSTP3£¢NwZ & tK”
U ¢¥epi+retb{\w!O2&di>-R hOuxz 2mwZe "+tE¢/ A  p

Ver—:"0zUcEgNIR>2U"A £b]
i Individual Shelfs b,ow MSTP«§"A¢ OADM S‘|yi+£U% a3£¢Nt ”
Netb{\w!03ai>-R hOuzUc¢%3EcN gxzU"Arefdoe{
3£¢N]gt g h3£¢Nqg o g b{
Node Protectiorr Aé¢ O%¢i a@puAT E"A-¢w» O>-R $b{ Same Shelft
h x Separated Shlevgsb {
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+ DCC Shelves Management -R hQuxzo+ Awa3f£¢Nipzpée A 12 t
TXP(P)_MR_2.5G8"A>eLb”\q>™ " 1h{

o TXP/MXP OSMINE placement -~R hOuxz OSMINE "¢"¢ctHlozA&ipUi
val Ue«pUiva 8" A>3£¢Nt "b"\q>™ " $b{

e Hbrid MSTP/MSPP Node -R - hOuxzb,owE"AUE Oae A MSTP/MSPPE "
Ag olR”Me"\q>™ " 1h{

+ Max Number of Shelves/Bay + Aweé Z2¢A~RItz+ Awrd,«t "pV”

C«§"AThxAATHUIT Y /] U¢«pUiva §"A>+< hE  ANSI thx ETSI3E
cRw7G:¢ 1 ™4£>-R $b{

+ Functionalitys Aé;,O%¢i suAT’ '+ Aw;6>-R tb{ T 2-24tz+ Af-
¢c’cw“A>O tb{+x AwZ Tixz;6t ao!"“Ib{x A z it
MMoxz CA& A®GUI @CS*|38"A8¢ A~ »€° 0 XiIAM{

MU Auto » E AE”«W Rt 0z7GVWJIEQU " «fb{ Cisco MetroPlanner

Xz WMyt)Q” pA>DOsv“7—vt oz+ A>f-"1b{
Pass Through \w+ Atx<+"> "“sM\g>™ " fb{

i Line amplifier « \w+ ApxzK’'«"i0a0O¢ add/dropE AANY ¢ « UD -7
th{
U OSC sitee MSTPE Aé”« gwhSt Optical Service ChannélOSC; !OAY §¢

i) BREGEtZ«-ub"DO6Q>2 tzE¢AE"«260 q 0+ A
sf-b"\g>™ " tb{AN¥cApxz\w+ Atyi+xE~ fetdae{

*Tz Cisco MetroPlannetJ E ¢ Aé"«tyi+UZApK"qQ.. hOuxz\w
+"tx"$t "pVib{ Cisco MetroPlannep xz OSC SitetE”AwaM2tzO &
2i0S |O"u»yi+>f ¢EMEPVED{

U Add/Drope \w+ Ati0ade¢ add/dropE6 —UK”\g>™ " fth{\w+ A

pi0ad¢ add/dropEUDO6swxzU TAA”U TAs¢S'| Pai-asti
Zpb{

i Hube ¢b qf wtMp£b,ow%RE¢>u0a0¢ add/dropEp V" * Ot z\
wt AtNYc»>+<b”\g>™ " $b{ EOIRpxz b,owd ifpu}”
Oits“thb{

U Gain equalizerr \w+ Apx WSS8§”A>—;"0zC\b” V>M3 216\

‘m> Ob"\g>™ " tb{\wx AxzAU¢%Oe«+ §"A>—;"sM
ROADM = Aq oig”etb{

U R-OADM « \w+ AU Any-to-Any gq<t Fixe¢aU FAA”U TAS"| Peai

—£A&ANY ¢« » O<xU”Ab"\g>™ " %b{
o« Types AéoO%cei s&uAT'+ A  » O>-Rtb¢ T 2-245€°£ {
U Auto » E;A8"«W ARt "0z7GVWJIEQU 'etb{ Cisco MetroPlanner

XZ WMV -¢At)Q” pA>DOsv “7—-vt oz+ A>f-"1b{

Glass Throughr O& 'a& AYwWyMyi+x A>™ " tb{

Lines O& |&@AYwoMyit A>™ " fb{

OADM = x VZ[SEQ NYg»¢ 1z2z4 %REgz 1z4 171A£>—;b”00a0
¢add/dropE A REG>+< h+ A>™ T fp{

B 32-WSSe 32DMX fhx 32DMX-O>+< h+ A>™ " ip{ \W!O3ai>—
ib"gz> w ROADM +">8M$t—;pVib{

¢«f 32-WSS>-R pV”wxz  System Release 7.0v '« 1 b {

M Mux/Demux e 32MUX-O S‘| 32DMX-O §”"A>—; zt wb,ow%RBE¢>
0a0¢ add/dropEb”z Full Multiplexer/Demultiplexe¢ FMD £+ A> ™ " tpb{!O
AYS8c¢ 1 ip>—;pVib{

Cisco MetroPlanner DVDM ! O @”3 47 " A
m. OL-10358-01-J |




| H2 -  Cisco MetroPlanner t'"E¢A&"«f -

26y0é6 E«AwSB ||

e AntiASE « + Awb,owd “REcU«T$ti0r06a0""'0tx A
>f brOuxz Yes>-R th{"'tz West -« 347 q East-«3&i wb,o
wi¢¥% AU “Znretb{ Anti-Amplified Spontaneous EmissiogsAnti-ASE£q 0+
A>f b"TrOT> Cisco MetroPlannet> ~d” Ol xz Auto >~ R fb{+
Af-¢c’cw“AtmMoxz T 2-24>€° 0 XirM{

2-24 % Af-¢"¢
CiiA
32116 CliA ~C 1iA ) L TiA )
%REC 8 “LRECc 64 %REc |32 %RE¢
| ;0 » |0 §"A 1033 100 GHz 100 GHz 50 GHz 100 GHz
Line Pass Through — — Yes Yes Yes Yes
Line amplifier Line amplifier — Yes Yes Yes Yes
Glass Through — Yes Yes Yes Yes
OSC site — — Yes Yes Yes Yes
Add/Drop OADM OADM §” A Yes Yes No No
¢ Anti-ASE £
Mux/Demux — Yes Yes No No
Hub Mux/Demux — Yes Yes No No
WSS 32DMX-O Yes Yes Yes No
32DMX Yes Yes Yes Yes
Gain equalizer WSS 32DMX Yes No Yes Yes
ROADM WSS 32DMX-O Yes No Yes No
32DMX Yes No Yes Yes
Line+ ROADM WSS 32DMX-0 Yes No No No
32DMX Yes No No Yes
Hub WSS 32DMX-0 Yes No No No
32DMX Yes No No Yes
Terminal Add/Drop OADM OADM §” A Yes Yes No No
¢ Anti-ASE £
Mux/Demux — Yes Yes No No
ROADM WSS 32DMX-O Yes Yes Yes No
32DMX Yes Yes Yes Yes
Terminal+ ROADM WSS 32DMX-O Yes No No No
32DMX Yes No No Yes
pHAcO 4 TiA T&Y"»>1Eb”txz&~s+ A i»”NE uto b” Project Explorerp z
C-Band thx L-Band >«a ¢« Tb{ PropertiesO® itz&~sZ—>0—"1b{
HA¢O 5 yi+widY”»>!Eb"txz&~s+ A i»NE pto b~ Project Explorer

p z C-Band Amplifiers 1 hx L-Band Amplifiers
+"tfwf <USMS$t&;"tb{AltmMoxz
[aY”»" ¢pl-12£>5€° 0 Xi*"M{

sea@ée« thb{ AutoZZw<>-Rb"qz
®1.6y Autoz ForcedzS*‘|  Locked

a. PropertiesO iw From Fibrenaeztz2As@C>0—"1b{

e« PRE+ Aé;0%cti @apAT &~sOxzi0¢
thx OPT-AMP-L [L-band]£>-R $b{

Nonez Auto z OPT-PRE [C-band]z
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« DCU12+ Aés0%¢i @pAT &~s DCU>-R ib{
o Attenuatore Aé,O%ei @ pAT’ &~snO0+>-R 1b{
« Output powers &~sZ—>0—"1b{
o Tilte &~s Vo>O—"1b{
o Attenuatore Aé;,O%ei @ pAT' n0+>-R fb{

b. PropertiesO iw ToFibreana@7tzzAs@C>0—"1b{

e« BST ¢« Aés;O0%UCi &puAT &~sO"u»¢ Nonez Auto z OPT-BST [C-band]z
OPT-BST-E [C-band]z OPT-AMP-L [L-band]zthx OPT-BST-L [L-band]£> =R $b{

« DCU12+« AésO0%¢i @pAT &~s DCU>-R ib{
« Output powers & ~sZ—>0—"1b{
o Tite &~s Vo>O—"1b{
c. PropertiesO iw Generalnezpz AésO0%¢i @pAT’ OSC>-R fb ¢OSC-CSM
thx OSCM £

pHA¢O 6 OADM i&Y"»>1Eb"Ouxz “pbr+ A i»NE uto b” Project Explorer
p Add/Drop >«ae ¢ « 1 b{ Properties® i1tzZAs@C>0O—"%b{

e Line/OADM oaezpzAésOvuti @UAT &~sn0+>-Rtb{
o Mux/Demux WSSeae 7tz2As@C>0O—"1b{
n PatchPaneb Aé;Ovcti epAT'l¢¥ TEg>-R EDb{

B Demuxe Aé¢O%e¢i seuAT 'AUc%Oe«+ ¢Auto B2DMX-O zthx 32-DMX £
>~ R fb{

26.4y+ Aw_t

EcAe"«T'2 A>_tb” gxziwgS“pb{+ A>_tpV’ wxz+ AU
Unlocked pA”AtK“zA&ANY ¢ « AUTAUFf "eoMsMOupb{+ A>_tp
V"wxz DesignpA”AWE ¢ Aée"«TiZpb{

pA¢ O 1 Project ExplorerO ipz+ AU UnlockedpA”AtsloM”\q>=Y $b{AltmM
0XZ ®2.74yE¢ A& «f-widVyY”» €o«rt™ €p.2-93Es>€° 0XirM{

HA¢cO 2 A&NY¢i« AUTAUK?Outxz_t ib{AltmMoxz ®2.6.9yA&NY s« AU
TAw_1T7 ¢p.2-8l1E>€° 0Xi*"M{

HAcO 3 NtView< E2 > »Opz Site 7 ir«ai«’z Tasks PaneT’ Delete>-R fb{ Cisco
MetroPlannerz “iwAltmMoxz Ca A®GUI @CS'|3a”A8¢ A~ >€° 0X

i"M{thxz Tasks Pang Delete>« e ¢ «  fb{=aYY¢ " U Orezt Aw_
ttmMo-YU{S’ «$b{

HA¢O 4 [Yed r«weaei« 0zx A> 1t 1b{
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265yYiAEip -i»w~R

E«C\ItE Ae"«tpOZza¥%>™ . b"YiALEiu ‘i»>8Ch” gqxz iwq
S“pb{\w;6>—:b"qzYiAEip i»w:S8120 &ileAYt,nMoz
edb"pOzw:">> pVib{YiAEip -i»xz Project Explorerw = Aw<z

Maintenance CenteN ¥ ¢ ¥4t O~ e$b{

MA¢c O 1 ProjectExplorerpzE¢ Aé"«  N¥cVirEwae« z3a"A§¢ A YC&”T' Expand
s~ R $b{
pA¢ O 2 Project Exploren <tp«é”¢ oz Maintenance Center N¥¢%>E«a ¢« z  38"A§¢
A YCAa”T’ New Maintenance Center> =R $b{
pA¢ O 3 Project Explorerpy " MYiA&£ip i»>S8 0 1b{
pA¢ O 4 PropertiesO itzZAs@C>O—"1b{
» Confidence Level YiA/Eip -i»pzAsuOzae¥i>sbqVwz"UEqs”"oT
S¢i”"-TAE>-Rtb{ 50z75z95zthx 991" -iApb{
+ Restocking time (daysy YiAZ£iu -i»te¥>4Fb”"hSwtAl ¢ ol >
%0£>O—\¢b{
pAcO 5 YiAEip i»xgx AwO CZtmMoxz ®2.63y+ A [AY"»w$B~ ¢p.2-71f
»€° 0 XiAM{
26.6yU TAA"U 1A AUiAwsB
U iAA"U 1A AUiA>$Bb” gxziwgS“pb{
MHA¢ O 1 ProjectExplorerpzE¢ Aé"«  N¥cVirEwae« z3a"A§¢ A YCa&”T' Expand
>R $b{
pA¢ O 2 Project ExplorerpzU iAA”U 1A AUiA>E«ai« z38"A8¢ A yca'T’
Edit >-R>fb{ Edit Pointto Point Deman#s ?é-@ ¢ «pU O~ etb¢ $ 2-41£

$ 2-41 Edit Pointto PointDemand Y% Zé-@ ¢«
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HA¢O 3 oWBLBRECW@CH!Eb"OuxzzZAs@BC>O—"1b{

+ Forecastr qOWY%REG>*RW%RECGtIEb”"Out-R fb{

o Srv.Typee Aé,0%cti @pAT &~sz"ip » O>aR tb{K"%RBEcw
+7ip » O>!Eb”qzb,ow%BEcw="ip » OUx"$tIEATDh{

+ Protectione Aé;O0%¢i @&@pAT'&~s-¢» O>-R tb{K"¥%LRE¢gw-¢
» O>IEb"qzb,ow%REcw-¢» OUx"$tIENetbh{

o Pathe Aé;0%¢i auAT' WCECbT'fE£fhx E¢fT'bE>-R tb{

+ Wavelengthe Aé;,O0%c¢i @pAT &~spO» O>-R tb{ Auto >-R hO
Uxz wMyt)Q" nuAU7-ts" Otz Cisco MetroPlannetd % REctp O> A
“pofb{

+ Optical Bypasss Aé;Ow¢i YCA'"T''OAYS§¢ I Tuo £ A>-R™t
b{

« WDMIntf.Type » Aé¢;O%ei @pAT &~s8§”A i»NE p » O>-R"
Ib{

« WDM Card Typee Aé;O0%¢i suAT &~s§”A » O>=aRtb{-;pV”
1O35ixz-R h§"A i»"NE p » Ot'lo>t“tb{K"%BE¢
w8"A » O>!Eb”qzb,ow%REcw§”A » OUx"$tIENetDb{

« SrcClientintf.e Aé;O%¢iT s2uUAT &~sl:«& ZiA i»NE p>-R
“tb{-;pVv"'O34ixz-R h§"A » Ot'lo>t“1b{

« DstClientintf.e Aé;O0%¢i s&uAT &~sd:«a ZiA i»NE p>-R
“tb{-;pVv"'O34ixz-R h§"A » Ot'lo>t“1b{

HA¢O 4 Yy M®%REG>aCbhb”Ouxz Edit Point to Point Deman#s 7é-@ ¢ «pWE pz Create
anewcircuitz i>«a¢« tbh{y ' Mé"U O"retb{ZAsiZ nAgs O 3>

“& zZy MBREGWIAY"»>O— "$b{

pHAcO 5 7 %RE¢> _tbh”"Ouxzé”>-R z Edit Point to Point Demands ?é-@ ¢ « pwE
pz Remove the selected circuit " T>«a¢ « fh{
HALO 6 [Ok] rcee¢« z¥%REGW!E>- "0z Edit Point to Point Demands 72 é-~@ ¢ « u>

a"Tzthx [Cancel >«ee ¢« z!E>- "SMp¥% 2é-@¢«pu> atb{

26.7yP &1~ AUiAwsB
Pei- +"Ip AUiAwx"Tp 6>!Eb” gxziwqgS“pb{

MHA¢c O 1 ProjectExplorerpzE¢ Aé"«  N¥cVirEwae« z3a"A§¢ A YC&”T' Expand
s~R $b{

HA¢ O 2 Project Explorerpz P &@i-n AUiTA>E«ae ¢« z38"A8¢ A YCAa’T’' Edit >-R
“tb{ EditP-RingDemands 72é-@¢«pU Oretbe¢ $ 2-42£
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$ 2-42 EditP-RingDemand Y1 Zé-@¢ «|

pA¢ O 3 Edit P-Ring Demand/s 2é-@ ¢ «up2As@C>0—"z Pai->!E tb{
+ Service Typee Aé¢O%eti @pAT &~sz"lu » O>aR tb{
« WDM Card Typee Aé;O0%¢i suAT &~s§”A » O>-R tb{-;pV”
'03%aixz-R hz"lu » Ot'lo>t“1b{
+ WDM Interfaces Aé¢;O%Uei s2uAT &~s§”A i»"NE p » O0>aR"
tb{—;pVv”"!034ixz-R h§"A » Ot'lo>t“fb{

Edit P-Ring Demand/s 2é-@ ¢ «uw  Circuitsaae 7tzZAs@C>0—"1b{

Rings ¢ OW E Pai-EU O~ etb{
Forecastt qOwW¥%REc>*RwW%RBECt!Eb"Out-R tb{

Wavelengthe Aé;Ovcei esepuAT'&~spO» O>-R tb{ Auto >-R hO
Uxz wMyt)Q" nAU7-ts” Otz Cisco MetroPlannet) % REctp O> A
upo:tb{

Edit P-Ring Demand/s 72é-@ ¢ «uw  Sectionseae 7tzzZAs@C>0O—"fb{

Srce ¢ OW E-«3diwl:+ AEU O etb{
Dste ¢ Ow £-«38iw4:+ AEU O"efb{
OptBypasss Aé¢O%.¢i ®pAT’'z qOWAUIAL Eb"¥BEG « T8t :

b"+ A>-R fb{ '1033iq o—;pV"wxz \W-«3aTiwipitk z
l:+ AT 4:+ Atpw tK"t AizZpb{
+ SrcClientintf.e Aé;O%e¢i s&puAT &~sl:«d ZiA i»NE p>-R
“tb{-;pVv"'O34ixz-R h§"A » Ot'lo>t“1b{
« DstClientintf.e Aé;,O0%¢i s&uAT &~sd:«& ZiA i»NE p>-R
“tb{-;pVv"'O34ixz-R h§"A » Ot'lo>t“1b{
HA;O0 4 y'M Peaei->a8Ch”0Ouxz Edit Point to Point Demandés 7é-@ ¢ «pw( pz Create
a new P-Ring circuitz Ti>«ae ¢« tbh{y Mé"U Oretb{ZAsiZ uA¢ O
3> “& 2y M Paei-wiay "»>O0—"1b{

(@)

Peaei-T'7 YBE¢>_tb"Ouxzé”>-R z

Edit P-Ring Demand/s 2é-@ ¢

«pw( pz Remove the selected P-Ring cirucait i>«a ¢« Tbh{
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HA¢O 6 [Ok]>«eei« z%RECW!E>- "0z Edit P-Ring Demand/4 2é-@ ¢ «u> a”
Tzthx [Cancel r«a¢« z!E>- "sMp¥s 2é-@¢«u> atfb{

2.6.8yROADM AUTAw$B
ROADM +"Tu  AUiTAwz"Tp 6>1Eb” gxziwgS“pb{

pA¢ O 1 Project Explorerp zE ¢ Aé” « N¥cY>E«ae« z38"A8¢ A YCA"T' Expand
s~ R EDb{

HA¢O 2 ROADM A&NY ¢« =¢”OsE«a¢ « 2 3A"Ag: A YCA&"T’ Edit >-R $b{
Edit ROADM Demand¥s 2é-@ ¢ «puU O”etb¢ $ 2-43£{
$ 2-43 Edit ROADM Demand Y2 2é-@¢ « |

HAcO 3 Aé O0%cei apAT AANY ¢ « »"i » O¢ Hub $hx Meshedf>-R tDb{
Hub >»-R hOuxz First SiteAé ¢ Ovi¢i @»iU—;DOts“tb{ Meshed> - R
hOGuxz pAsO 5t “fb{

pHA¢cO 4 AANY¢« » OU HubwOuzFirstSiteAé o Ovcti esepAT'1:x A>-R tb{

pA ¢ O 5 ConnectivitytypeAé ¢ Ovat¢i @ pAT € » O>-R tb{-RTx Protectedz
Unprotected Minimum Hop z Unprotected Optimum PathzS ‘|  Unprotected Subnetpb {€ »
Ow-RIwWAItmMoxz ®1.5.3y ROADM A4ANY ¢« AUTA™ ¢pl1-11£>5€° 0X
iAM{

HA¢ O 6 Service TypesD ipz ROADM AUiAt0 b"«8 ZiA £7p » Ow@e«p> 1
mZi-R fb{ E wO itz ax"lp » O>xU"Ab”«& ZiA i»"NE
LU Oretb{
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HALO 7 «8 ZiA i»NE pwAl> [b"hStzE wO iwé”]qtziw!O
381>0—"th{-e" Ow%Es«@D ¢ «puxzed ZiA i»"NE pw-Rt
x—;pVidee{

+ Yes/Nos \w8§"Apz"ip » O>1+b”0Out-R $b{
+ ClientInterfaces - R hz"ip » Ot0 b"§"A » OU ONetb{

e Y-Cablee € » OU ProtectedpK“z Y E -"Oc¢p-¢b”Out-R fb{

o 1+1Protectecd € » OU ProtectedpK“z 1+1MUp-¢b”O0t-R tb{

+ Fiber Switched* € » OU Protectedp K“z« N« |
Ut-R tb{

+ Supported Service §”"Ap+U”Are"+"Tp » OU O7etb{

U ¢%i-t'lo-¢b”0

%oax”Ty » O>xU"Ab"«& ZiA i»NE p>6:-RpVIb{ANY¥
¢Apxz CiscoMetroPlannet‘loz o+ "TpwzU"At7&s«8 ZiA i»"NE
HU-RAetb{

pAsO 8 [Okl>«aei« 0zAUTAWIE>- “$b{

269yAaNY¢« AUTAwW_ 1

AaNY¢« AUTA> Th"txzAANY ¢ « AUiTAU UnlockedpA”AtsloMs

Zeys“tdoe{AaNY, « AUiA>_tb” gqxziwgS“pb{

MA¢ O 1 ProjectExplorerpzE¢ Aé"«  N¥cVirEwae« z3a"A§¢ A YC&”T' Expand
»-R 1b{

pA¢eO 2 AUITAU  Unlocked nA”AtsloM”\g>-Y tb{AltmMoxz ®2.7.4yE ¢ A
"« f-wiay”"» 6e«rt™ ¢p2-93E>€° 0XiAM{

nA¢ O 3 Project Explorerp _th”AUTA>sE«ae ¢ « 2z 3a"A8¢A  YCA”T’ Delete>-R"

fb{thxz Tasks Paneg [Deletd >«a¢ « tb{
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2.6.10y«Ne | [AY"»w$B

072zS'|x'w«Ne 1>

niizOzzs*|«Ne |

Properties® i>—;b"gqz«Ne | pitz«Ne i

gpViIb{«Ne |
Mtb{ =~ 2-25tz«Ne 1

O7xz 2SwVY¥s’«Ne I¢CEs“S'|(s“EpIR”+0
uiizOzzthx«Ne 1t "0z!EpV"OéIAY

>O 1b{
T 225 $BD6s«Ne | O¢éiAY
O¢élAY «Ne 1 i «Ne Oz |«Ne i
Name Yes Yes No
Ageing loss Yes No No
Ageing factor Yes No No
Fiber type Yes Yes No
Fiber length Yes Yes Yes
Length-based loss Yes Yes Yes
Connector loss (per site) Yes Yes Yes
Absolute loss without connectors Yes Yes No
CD factor Yes Yes No
PMD factor Yes Yes No
Loss Yes Yes Yes
«Ne | piizGzzs |«Ne IwidY”"»>$Bb” qxziwgS“pb{

pA¢e O Project Explorerp z Fibers N¥¢¥i>E«eae ¢ « 238"A8¢ A YC&"T’® Expand>-R

=
>

(@}

“ib{

Project ExplorerAa "pziwMceT

"1O34ixz-Rt'loYs“th{

. «Noi
. «N'i

Imr«aed« Th{

uii>$Bb”Ouxz¥a«A
O072>$Bb"Ouxz«Ne |

e x‘'W«Ne 1>$Bb"Ouxz«Ne |

ID>«cae¢« th{
Oz ID >« Tbh{

ID>«eae¢ « Tb{

PropertiesO ip$Bt—;pV

pA¢ O Properties® ipzzAt aolwidY"»>$B tb{«Ne I piiz«Ne |
O7zthxx‘w«Ne It "0lEpV"OéiAYtmMoxz T 2-25>€° 0Xi
/\M{
« Names «Ne 1 piizOZ2zthx«Ne 1t0 b”"z&~sE2>0—"1b{

+ Ageinglosse EOL 8" 1= ;@ >O— "tb{plip“w

«w«Ne 1]gtz
wOUux EOLU" i>C% £
ZAXK*fdoe(

« Ageing factore «Ne Two” i= (>O0—"1b{\w :tz E«»> fsM

{=” 0=

SOLiuiT e>»Zu~dtb{a” 1= &>f hOuze” i-

b"zAxK“+doe{

o Typee EiAé"«wapiitmMoz«Ne |
+ Lengthe pii®G>O—"1tb{ O"e"0exz

“Aeth{

» O>—|R\¢b{

EOL @&«xzE¢sAg”
End Of Life¢ EOL; 1;E:£tC% "*fb¢hqQyzu0Oa u
H>f "hOuzae" i- &>f b”

o f

Span Measurements Unit¢ Y "¢ AT
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+ Length Based Loss «Ne 1 &>°0¢q 0! b”Out-R tb{«Ne |
&>ulidT'%VvzZbOuxz°-Rt 0SVib{

« Connector loss [Site 1§ piiw4 " “wBo E«» a&>0—"1b{

« Connector loss [Site 2] piiw4 " “wBo E«» s&>O—"1b{

e Abslossw/oconn[dBF "E«»Br @> tsMzopliitSz” Start of Life¢ SOLE
®i««Ne T &8>0—"12b{E«»> tsMi SOL &xz e :t0%>»
Zu~dh<ts“tb{ Length BasedP Agpxz\w<Ux"$t-% et b{

e CDe+ «Ne i CD (>O—"tb{AN¥¢cA«xz-R h«Ne I » Ot'l
0Ys“tb{O—"hexz«Ne | » O>lEb"h|t«"retb{pOi,x
7cz psiimkm UpO—"tb{«Ne iwpOiu,xzpO3-we p [~eF
b{ CIiiAx 15453 nmp ["ez L1iAx 1590.4nmp [~etb{

« PMD+ PMD (>0 —"1tb{AN¥¢A«xz-R h«Ne I » Ot‘loYs*
tb{ O—"h«xz «Ne 1 » O>!Eb"h|t«"retb{ PMD xZcz ps/nm/km
UpO—"1thb{
o Losse mE¢AE"« piiw &>-%b"hSt—;b"z0&éY "Agp“w SOL «
Ne I ewo>O—"3b{«Ne | & :xZcz dBkmw UpO—"1tb{
HA¢O 4 7At aoz«Ne | piiz«Ne | Ozzthxx‘w«Ne itmMoz Properties
O ipiwu->-Y tb{
e LossBOLs ¢ OW " £%Z"<h Beginning of Lifet BOLEwU- eeU " Oret b
¢«E£ BOL x SOLq<MMth{
e LosSEOLe ¢ OW £-%"<h EOLwu- &@U O7etb{
e« CDe+ ¢ Ow £ipOu,UO"etb{
« PMD+ ¢ OW"£i PMDU O7"etb{
2.6.11y Fibres Dialog t*"«Ne | niizOGz2zs*|«Ne Tw$B
Fibres Dialogtx zE ¢ Aé”«°wb,ow«Ne 1] uiizGzzs*|«Ne TUTO
ANetb{ FibresDialog@ ¢ «puT «Ne | faY"»> 0 0%$Bb” qxziwg$s
“pb{
pA¢ O 1 Project ExplorerAa " pz"pb”E¢ A& «w Fibers N¥cYs>E«a¢ « 234 A8 ¢

A YC&”T’ FibresDialog>-R +b{ Fibres DialogU O”«fb¢ $ 2-44£
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$ 2-44  Fibres Dialog

T 2-26 pz Fibres Dialogwa§aUtmMot1 tb{

~ 2-26 Fibres Dialog w§aU

§4U °0

Name «Ne 1 uiic Duct£zOZ¢ Couplefzthx«Ne TWE2U
“Onretb{ DuctEw#wO&aut +£Gor«ae¢i«b’qzap
AU2% "~+z Couple EU O"etb{ Couple Ew#wOAauet +£
Gor«ri«b’qzaepAU2% Nezx ' W«Ne TWE2U
“ONetb{

Src. «Ne 1 nmiizOzzthx«Ne Twl:x Afhx i
»"NE pwE2U O7etb{

Dst. «Ne 1 niizOzzthx«Ne Twad:x Athx i
»"NE pwE2U O~ etb{

Type E¢cAé"«woplitmMoz«Ne 1 » OU ONetb{
G652-SMFz E-LEAFz $ hx True Wavep b {

Length HitOU ONretb{ O”e"0exz Span Measurements Units
NY"cAT "~etb{

Loss SOL % Z"eh Startof Life¢ SOLEWT s,e U O et b

Loss EOL % Z~eh EndofLife¢cEOLEWi seU O”etb{

CD C-Band CliAwipOu,U " O7etb{

CD L-Band LITAwipOu,U " 07etb{

PMD i PMDU O7"etb{

QD C-Band CITAWETUO,U OretDb{

QD L-Band LITAWEIU, U O”etb{

RD aiv%U0,<U OMetb{
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«Ne 1 uiizOzzthx«Ne 1>$Bb"txz Fibres Dialogp“pb”%2 AU>
«@ ¢« Th{ FibresDialogE w PropertiesO itz-Rhz AUwWOéIAYU O~*
e1b{

PropertiesO ipzzAt aoiwidY”"»>$B tb{«Ne« | piiz«Ne |

OZzthxx‘w«Ne It "0lEpV"OéiAYtmMoxz T 2-25>€° 0Xi

e Names «Ne | uiizOzzthx«Ne 1t0 b"z&~sE2>0—"1b{

o Ageinglosse EOL 8" 1= ;e >O— "tb{plip“w EOL &«xzE¢Ag”
«w«Ne 1]qtz End Of Life¢ EOL; 1;E:£tC % "*3b¢hqQyzp0O4a p

wOux EOLU" i>C% £ {2” i-~ :>f "hOuza" i~ &>f b”
ZAxK“tdoee({

« Ageing factore «Ne Two” 1= (>O0—"%b{\w :tz E«»> fsM
SOLipii @>»Zu~dtb{a” i~ a&>f "hOuza” i- o f
b 2 AxK*“tdoe{

e Type « Ei A&’ «wopiitmMoz«Ne | » O>-aR tb{ G652-SMFz
E-LEAF zthx True Wave pb{

« Lengthe pii®G>O—"tb{ O"e"0exz Span Measurements Unif¢ Y "¢ AT
“Netby

« LengthBasedLoss «Ne+ 1 @>"0<q 0! b"Out-R tb{«Ns i
&>ulidT'%VvzZbOuxz°-Rt 0SVib{

« Connector loss [Site 1] piiw4 " “wBo E«» s&>O—"1b{
« Connector loss [Site 2] piiw4 " “wBo E«» a&>0—"%b{

+ Abslossw/oconn[dBF "E«»Bo @> tsMzapliitSz” Start of Life¢ SOLE

®i««Ne I &8>0—"1b{E«»> tsMi SOL &exz @& :tO">»
Zu"dh<ts“tb{ Length BasedP Agpxz\w<Ux"$t-% et b{

+ CDs+ «Ne1 CD (>O—"tb{AN¥¢A«xz-R h«Ns I » Ot*l
0Ys“tb{O—"hexz«Ns I » O>1Eb”h|t« " ?etb{pOi,x
zcz psinmkm UpO—"tb{«Ne TwpOi,xzpO3-wno p [~ef
b{ CliAx 15453nmp [~+z L ITAx 1590.4nmp ["+%b{

e« PMD+ PMD :(»>O— 1b{AN¥cAcxz-R h«Ne | » Ot‘loYs*
tb{ O—"h«xz «Ne 1 » O>IEb"h|t«""etb{ PMD xZcz ps/nm/km
UpO—"1tb{

o Losse sEg Aé"« pliw &>-%b"hSt—;b"z0éY"Acp“w SOL «
Ne T ewo>O—"1tb{«Ne+ | & :xZcz dBkmw UpO—"1tb{

Cisco MetroPlannet‘lozy M«p Fibres Dialog@ ¢ « fUEy~etb{

7At aoz«Ne | niiza«Ne 1 Oz2zihxx‘w«Ne itmMoz Properties

O iplwu->=Y fb{

+ LossBOLs ¢ OW £%Z"h Beginning of Lifec BOLEwWU- &eU OMetb{

¢«f£ BOL Xx SOLg<MMiZIb{

e LosSEOLe ¢ OW £-%"<h EOLwu- &aU O7etb{
e« CDe+ ¢ Ow £ipOu,UOretb{
e« PMD+ ¢ OW"£i PMDU O7Metb{
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HA(',O 5 [Ok] »«ae¢« th{

26.12yE¢Ae"«w«Ne | niizO0zzS*|«Ne lwo«pU”A
XLS N¥"U¢Apa«pU”

EcAé"«wb,owpliiz
Ab” gqxziwgS“pb{

O072zS'|x'w«Ne 1>

Fibers N¥cYi>E«a¢ « z38"A8 ¢

pA¢ O 1 Project ExplorerAa”pz"pb”E¢ A& " «w
Fibres DialogU " O”etb¢  $ 2-44£{

A YCA”T’' FibresDialog>-R tb{

HA¢O 2 Export s«a¢ « tb{  FibresExportys 2é-@ ¢ «puU O”etb{

pPA¢O 3 &~sAYeé«Aet "'z XLS Ne ¢wE2:0—"072 [Savd >«ae ¢ « b{

2.6.13y«Ne | pitw_t
EcAé"«f-T'«Ne | uii>_tb” gxziwgS“phb{

MHA¢c O 1 ProjectExplorerpzE¢ Aé"«  N¥cVirEwae« z3a"A§¢ A YC&”T' Expand

>=R $b{

pA¢ O 2 ProjectExplorerpz_tb %« AsE«ae ¢ « z34"A8¢ A YC&"T' Delete>-R"

fb{thxz TasksPane [Deletd >«a¢ « $b{

HA¢O 3 [Yedr«waei« 0z«Ne Tw_t>-Y $b{

2.6.14y+ Aw ”
+ Ax 4 "wliRtu"do "pVib{iRta"dox A> "b”zthx Cisco
MetroPlanner¢ YiA¢t O”e”*Otzb,owx A> "“~d” qxziwgqS*“p

b{

HA(,(') 1 NtView< E2 > »0>«a¢« tb{

pA¢e O 2 Arrange Siteshé s Ovati esephAr«es« ziwMceeT 1m>-R tb{

¢«E Yxb,0UAOt “tDb{

Fit to visible rectangle view NtView< E2 > »Owb,owzx AU O”r«" 0Ot]"U

“ib{
« Arrangeto anellipse b,ow* As*
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EcAé«>f-"ols hKqgpz gu»U” =+ Atfwf-><OpV”'Otjcb
"FAUK“tb{E¢A&"«w<O™z6Sis 08JUKey.YpVib{

E¢cA8 «f-txpA”ACYBEUMXmcK“Fb{

o Design s YFE A€ «f-w7sWYB{E¢A8"«f-wWK’«"AE>4Cz_
tzihx!EpVib{ Design uA”Apxé¢«x O tdoe{f-wis™z Tasks
Panep Design>-Rb"qz6| DesignpA”Ati o!EpVib{

+ Design-Analyzed s E¢Aé"« Z2/E8 2lee™WE A8 " «f-wY6{b,owe
U"AUb;DOpK“zEy~retb{E¢sAé"«f-wrwAEtmMo<!EpVi
dee{-é"li¢ AYugciAepOzae¥%>'Eb”srz BoM x!ED6pb{E¢
Aé"«wiis™z Tasks Pane Design>~Rb”qz DesignpA”Atidib{

e Copy* EiAE"«w D"{EsA8"«Ww D"XrwuA"Ap<*RpVib{™
D"xz "t _fsf-10%8i>ApuAb ’qVt(bpb{ BD"xXzE¢ A& " «>
isb"2p<Kqp<«*"RpVIb{ D" hEs A& «xziwWE A& «p |
Neh°EwOé £«A 1034i>%V'Wib{AltmMoxz ®2.71yE¢ Ag”
«w D""R ¢p29lE>€° 0o Xir"M{

o Installe EgAé"«x7szgaiwaNe 1<¢ a@zOrSreEs>—; 0f-"o

tb{E¢A&"«>TMt<O hgqVtziMw«Ne | [aY"»>0—"04Y
PV OtzE¢ A& «> Install uUA”At!EpVib{ Install E¢ A8”«>~Rp
V”wxz Design-Analyzed: hx Upgrade-Analyzedu A" AWE ¢ A€”«T ' pb{ Install
MA"AWE ¢ A&7 «xz Us hE¢Aé"«p ["*oMh°EwOé £«A o)
3AT>YV WiEDb{ Install E¢ Aé”"«wx Axb,0é¢«Metb{pli &

Y’»q¢éi«rsoMsM+t AWEVi+>TVZE A& «f-WrwAE<E
pVidoe{hi'z BoM x!'EpVib{¢"AYi-~shs¢xb,o{ "ez\w

HA"Aw x!'EpVide{AltmMoxz ®2.7.2y Install UA”AWE ¢ Ag”«wn
R ¢p.2-91£ >€° 0 XiAM{
o Install-Analyzede E¢Aé"« Z/£8 21ee™w Instal E¢ A8 «f-wY6{ b,ow

eU”AUb;D6pK"“z Eyretb{ E¢Aé&”«U Install-AnalyzedpA”"AwqVxz
b,ow+ AzAUiAzS‘|+"Ué¢« etb{

o Upgrades E¢Aé «f-1tzql:pi+b”"%RBRE¢:q*R¢" £1+b"%R
Ec:> ["¥b{E¢A&"«wcO™z' “hs¢>i+b”"TrOT>> pVit
b{fwOuxz UpgradeE¢Aé"«>AR z1+b"" thxA&NY ¢« AUTA
+"Tu>-R tb{ Upgrade E ¢ Aé”«>*RpV”wxz Design-Analyzedt h x
Install-Analyzedp A" AWE ¢ Aé"«T'pb{> widY"»wéi«>rt oz’
BRECS'|AANY ¢ « AUTAUE" f«"'Otf->!EpVib{ Upgrade
HA"AWE ¢ Aé”"«xz Us hE¢Aé"«p ["*oMh°EwWOé £«A o)
331H>%V'Wib{AltmMoxz ®2.7.3y UpgradeE ¢ A8" «W~R™~ ¢p.2-92£>€
S o XiAM{

« Upgrade-Analyzed E¢Aé"« Z/E& 21ee™w UpgradeE ¢ A& "« f-wY6{ b,
oweéU”AUb;DOpK“zEy~retb{E¢sAE"«U Upgradepy A" AwqVxz
b,owt AzAUTAzS'|+"Ué¢« etb{

\Wptib"a g>leeb”txzO0&é £«A>%VZE;AE"«>€é”A 0SXZA

UK*“tb{ ®2.1.1y0&é £«Aw% VM~ ¢p2-3ES*'| ®212yE A& «wé”"AS"|
Zié"A™ ¢p24£5€° 0 XirM{
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271yE¢Aé”«w D"AR

E¢Aé"«w D">"Rb"txzpA"At sXzEi Aé"«>E«ae¢« 0z
38"A8,A  YCA'T' Copy>-R'ib{ Network Mgmt Tree» Oty M B”U 0
Aetb{

272ylInstall pA”AWE¢Aé"«wAR

Install PA"AWE ¢ Aé”«>2"Rb” qxziwqgS“pb{

HA¢O 1 E¢Aé"«>fitisoMsMOuxz ®2A4yE¢sAé"«wiis™ ¢p2-4lfEw griee’
th{

pHA¢ O 2 Networks Mgmt Tree » O>«ae ¢ « fb{

HAcO 3 E¢Aé "« E«ae« z38"A8¢A YC&"T' Install >-R > tb{ Networks Mgmt
Treetz Install uUA”Awy ME¢Aé”«U Oretb{lis hE,A&"«T’b,0
WALU Install E¢ A& «t TU"Arez Locked P"AtAe b

HA¢cO 4 ZAt aoz Install E¢AE"«>1E tb{$BpV "«Ne | faY"»xz«Ne
I e@cz«Ne | CDz«Ne | PMDzS‘|«Ne+ 1Opb{ ®2.6.10y «N e 1| ui
120228 |« | [A&Y"»W$B~ ¢p2-82£>€° 0XirM{t A fay”
»Wé¢e«rrt olEb"\q«pVib{z A [&Y”"»>1Eb”"Qutxz ®2.6.3
+ A TAY"»wW$B~  ¢p2-71£>€° 0 Xi*M{

HA¢ O 5 Networks Mgmt Treela”pzA"¢i”w Analyzed Network 7 “i>«ae ¢ « 1h{ Cisco
MetroPlannerz “iwAltmMoxz Ca A®GUI @CS'|3a”A8¢ A~ »€° 0X
i*M{ MetroPlanner Analyzer statu6YiA¢tz @Y U O”etb{thxz Tasks Pane
p [Analyze] >«ee ¢« tb{ CiscoMetroPlannew ispA”»u  1"pzE¢;Aé"«usU
if h\qU " T“tb{E¢Aé&"«x Install-Analyzed u A" Ap O e” Ots“%
b{

t«E QqOWE; A&« ¢ 7¢CAqAlb" ' OsiaY"»1E>aelhOuctyi+U
xapVsMZ— V<« f b'srE ZE¢i Aé " «ilisat Analyzer Message® i
tad” Y¢ " U O07rez3I>%VIV oM "[AY"»UONtb{/

S‘|ed” Yeé-" > UT“tzqOwf-t Eb”8J>¥V-S”\qUp
Vib{ b,ow3puAU Yé¢ " >a0 haepAtmMoxz ca®3pAU Y
T €T o XiMM{

HA¢O 6 E¢Aé"«>iis’0ALtdIJUsMOuUxzE Aé"«wax Atzy X\R~”eh
inAr¢ fay”»> TU”A fb{AltmMoxz ®2.5.2y NE Update N+ ¢w -
T ¢p.2-44E£ >€° 0 XiMM{
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2.7.3yUpgrade E¢;Aé”«w”R

=

=

UpgradeE ¢ Aé " «pziw”rA>eeMitb{

. <_fN° I uiiwOéiAYedrzi,z PMD :z0a a&zo” i-srf>!
E tb{

« AANY «>8Cthx_t1 $b{

e RWAANY¢«>qOWAANY ¢ «t!d tb{

« ROADM A&NY¢«>qOWAANY ¢ «t!1d tb{

e« E"A » O>IE fb{

« §"Afthxbp a"c¢tyi+z OSCbhb 4”¢cz OADM §"AzS‘| DCU b &"¢E
w OFfhxAZO>8M$t&; tb{

UpgradeE ¢ Aé”«pxz> w TpA”g [AY"»>8M$t&;pVEDb{

< Amplifier per-channel output power setpoint

« Amplifier output tilt setpoint

« OADM card aggregate output power setpoint

e Full multiplexer/demultiplexer or ROADM output power setpoint
UpgradepA”ApxziwidY"»x!EpVidee{

* Node input channel fail threshold

* Node OSC channel fail threshold

e Preamplifier input power threshold

« OADM card aggregate input power setpoint

¢ Full muxponder/demuxponder or ROADM input power setpoint

e Channels drop power

EcAé”«> UpgradepA”Atb” gxziwgS“pb{

A¢O E¢Aé «>titis’oMsMOuxz ®24yE A& «wis™ ¢p2-41fw griee’
th{

AsO Networks Mgmt Tree » O> «a ¢ « 1 b{

AgO USAE¢Aé"«>Ewae « z38"A8¢ A YC& T’ Upgrade >- R fb{
Network Mgmt Tree» Oty M  UpgradeE ¢ Aé”«U O"retb{lis hE¢A&"«T
'b,owALU UpgradeE ¢ Aé”«t TU”A”etb{

A¢sO 7At aoz UpgradeE o Aé"«>!E $tb{AltmMoxz ®2.6.10y « N o 1| uiiz
0z72zS|«Ne | [AY"»w$B~ ¢p.2-82£ S‘| ®263y+ A [4aY"»w$B~
¢p.2-71£ > €° 0 XiAM{

A¢sO Networks Mgmt Treel 4" pzA”¢cl”w Analyzed Network 7 “i>«a ¢« tb{ Cisco
MetroPlannerz “iwAltmMoxz Ca A®GUI @CS'|3a”A8¢ A~ >€° 0X
i*M{ MetroPlanner Analyzer statusYiA ¢tz @Y U Onretb{ thxz U™Mwia”
w Tasks Pang [Analyze] >«a ¢ « tb{  Cisco MetroPlannewiisuA”»pu  1"pzE¢ A
8"«UsUTf h\qU " T“tb{E¢Aé"«x Upgrade-Analyzedu A" Ap O "e”
‘Ots*“th{
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C«E QqOWE¢A&"« & 72¢6AqAIb" OsiaY"»!E>aelhOucyi+U

xapVsMZ— V> f b'srE ZE¢ Aé " «ilisat Analyzer Message® i
tad” Y¢-" U OMez3I>%VIV oM "{AY"»UONtb{/
S‘|md”  Y¢-"> UT“tzqOwf-t Eb"3J>¥V-8§"\qUp
Vib{ b,ow3pAU Yé¢ " >a0 haepAtmMoxz caa3pAU Yy
T L o XiIAM{
274yE¢Aé "« f-wilidY”» é¢«rt
Locked pA”AU\a"wxziaY”"»t>f ¢EM&;E°SMpzE™“t Auto > -
R hOupb{EsAé"«lslitz Cisco MetroPlannex Auto Uf ~ehoidVY”"»t
OA“pozferwidyY”»> Locked pA"At 1 b{ Locked pA"AxziszE¢

Aé"«>is hqVtzz/A48 2UIEpVYsM\g>™ " tbh{+x A>é¢«b
"qzZ2wz/E48 21®ALq ot AthxEgAé"«UZAqb"b,owOeazi

0zO u»zu0aO¢  addidropfENYc»zS*| DCU §”AtmMoz OfhxZAOUS
M$t&; ;" etb{é¢« e hAEXZ Project Explorerpx ah &~ awz “ipO~e
tb¢ $ 2-49£{ AutozForcedzS‘| Locked pA”AwAltmMoxz  ®1.6y AutozForcedzS

‘| Lockedl&Y"»~ ¢p.1-12£5€° 0Xi*M{

$ 2-49 Project Explorer t O”fehéi«Yb6wzx A

EcAé"« TiIU'EiAwéi«rrt oldY”»>$Bb"txz Project Explorerp ™
Pb"AE>E«a¢« 238 A8 ¢ A YCA”"T’ Unlock >=R $b{

275yE¢ A& "« f-w JPEG ~R

EcAé " «f-wpE e O3a¢ A JPEGN¥"U¢Ap~"Rb” gxziwgS“pb{
HA¢O 1 NtView< E2 > »Os«a¢ « Th{
HA;O 2 2At ao  ®26.14y+ Aw "~  ¢p2-86E>Tae zE¢Aé"«°w: AU&~s "
p» Ot ONe" Ot £b{
pHA¢O 3 A"cgi”w  Save network view imagé “i>«a ¢« tb{
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APPENDIX B

ID>GL hephsop the™

Cisco MetroPlannep = U”A~«” i»"NEf pS*|8”Aw» Oqzf

B-1 ™B-29£{

\WCAap8§ AEt®

MetroPlannerw " Opxz ® y U! ~"eoMib{

Cthx® L U! "«oM”’OUzE¢A&"«lis2w

Cisco

® _y xz Cisco MetroPlannet) O é £ « A

ARIt-R”"*h3-t a0z CliA 8§8"Athx LIiA 8&"Awrj’T>—;b”
\g> " Fb{
T B-1 0OC-192/STM-64 ¢ 9.953 Gbps £
i»"NE Tt » 0 §"A » O ¢» O avh ID
AdipUiv, TXP_MR_10E_CS'| «8 ziA  1+1 15454-10E-L1-C=¢ C 1TA £
o
TXP_MR_10E 2z EFEC YE -"O¢ 15454-10E-L1-L=¢ L 1iA£
AdipUiv, TXP_MR_10E_CS | «8 ziA  1+1 15454-10E-L1-C=¢ C ITA £
o
TXP_MR_10E |2z FEC YE -"O¢ 15454-10E-L1-L=¢ L 1iA£
AdipUiv, TXP_MR_10E_CS | «8 ziA  1+1 15454-10E-L1-C=¢ C ITA £
TXP_MR_10E Lz FEC s YE -"O¢ 15454-10E-L1-L=¢ L 1iA£
AdipUivs TXP_MR_10Ez EFEC °© & Zi1A 1+1 15454-10E-L1-xx.y=¢ C ITA£
YE -"O¢ 15454-10E-L1-xx.y=t L 1TA£
AdipUivs TXP_MR_10Ez FEC ° & Zi1A 1+1 15454-10E-L1-xx.y=¢ C I1TA£
YE -"O¢ 15454-10E-L1-xx.y=¢ L 1TA£
AdipUivs TXP_MR_10EzFEC s~ <& ZTA 1+1 15454-10E-L1-xx.y=¢ C ITA£
YE -"O¢ 15454-10E-L1-xx.y=¢ L 1TA£
AdipUiv, TXP_MR_10Gz FEC ° & ziA 1+1 15454-10T-L1-xx.y=
YE -"O¢
AdipUiv, TXP_MR_10GzFEC s <& ZiA 1+1 15454-10T-L1-xx.y=
YE -"O¢
ai 8§"A OC-192 LR «8 ZiA 141 15454-192L-1-xx.y% ANSI £
STM-64 LR 15454E-64L-xx.y=¢ ETSI£
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cas §"A » O
[ |
T B-2 OC-48/STM-16 ¢ 2.488 Gbps £
i»"NE p »0 |8"A » O ¢» O avh ID
AdipUivs TXP_MR_2.5G «d& ziA 141 15454-MR-L1-xx.y=¢ 1 - ¢ £
TXPP_MR_2.5Gz FEC © YE -"0Og¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne | TRRZY.
AdipUiv, TXP_MR_2.5G «8 z1A 141 15454-MR-L1-xx.y=¢ 1 - ¢ £
TXPP_MR 2.5 FECs" YE -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne i U ¢ %A
AdipUivs MXP_2.5 10E_CS*‘| «d ziA 141 15454-10ME-L1-C=¢ C 1TA £
o]
MXP_2.5_10E |z EFEC YE -"O¢ 15454-10ME-L1-L=¢ L 1iA£
AdipUivs MXP_2.5 10E_CS ‘| «d ziA 141 15454-10ME-L1-C=¢ C 1T A £
MXP_2.5 10E_Lz FEC ° . . .
i YE -"O¢ 15454-10ME-L1-L=¢ L 1iA£
AdipUivs MXP_2.5 10Ez EFEC ° a ziA 1+1 15454-10ME-xx.y=
YE -"O¢
AdipUivs MXP_2.5 10ETz FEC ° a ziA 1+1 15454-10ME-xx.y=
YE -"O¢
AdipUivs MXP_2.5 10Gz FEC °© a ziA 1+1 15454-10M-L1-xx.y=
YE -"O¢
AdipUivs MXP_2.5 10Gz FEC s <& ZiA 1+1 15454-10M-L1-xx.y=
YE -"O¢
ai 8§"A OC48ELR / SMT-16ELR «d ziA 141 15454-048E-1-xx.¢ ANSI £
15454E-EL16HSxxyy<$ ETSI£
~ B-3 OC-12/STM-4 ¢ 622 Mbps £
i»"NE p »0 |8"A » O ¢» O avh ID
AdipUivs TXP_MR_2.5G «d ziA 141 15454-MR-L1-xx.y=¢ 1 - ¢ £
TXPP_MR_2.5Gz FEC © YE -"0Og¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne i u ¢ %A
AdipUiv, TXP_MR_2.5G «8 z1A 141 15454-MR-L1-xx.y=¢ 1 - ¢ £
TXPP_MR 2.5 FECs" YE -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne i u ¢ %A
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| caB §'A » 0
||
~ B-4 OC-3/STM-1 ¢ 155 Mbps £
i»"NE p »0 [8§8"A » O ¢» O ay ID
AdipUivs TXP_MR_2.5G «& ZiA  1+1 15454-MR-L1-xx.y=¢ 1 - ¢ £
TXPP_MR_2.5Gz FEC © YE -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne T p ¢%A
AdipUiv TXP_MR_2.5G «& 2iA 141 15454-MR-L1-xx.y=¢ t - ¢ £
TXPP_MR 2.5 FECs" YE -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne T p ¢%A
~B5 10GE WAN PHY ¢ 9.953 Gbps £
i»"NE p »0 |8”A » O ¢» O avh ID
AdipUivs TXP_MR_10E_CS"‘| «& ZiA  1+1 15454-10E-L1-C=¢ C 1T A £
TXP_MR_10E_lz EFEC ® YE -"O¢ 15454-10E-L1-L=¢ L 1T A£
AdipUivs TXP_MR_10E_CS"‘| «& ZiA  1+1 15454-10E-L1-C=¢ C 1T A £
TXP_MR_10E_Lz FEC © YE -"O¢ 15454-10E-L1-L=¢ L 1TA£
AdipUivs TXP_MR_10E_CS"‘| «& ZiA  1+1 15454-10E-L1-C=¢ C 1T A £
TXP_MR_10E Lz FEC s~ YE -"O¢ 15454-10E-L1-L=¢ L 1T A£
AdipUivs TXP_MR_10Ez EFEC ° q4& 77T A 1+1 15454-10E-L1-C=¢ C 1T A £
YE -"O¢ 15454-10E-L1-L=¢ L 1T A£
AdipUivs TXP_MR_10Ez FEC ° q& ZiA 1+1 15454-10E-L1-C=¢ C 1T A £
YE -"O¢ 15454-10E-L1-L=¢ L 1T A£
AdipUivs TXP_MR_10EZFEC s <& ZTA 1+1 15454-10E-L1-C=¢ C 1T A £
YE -"O¢ 15454-10E-L1-L=¢ L 1T A£
AdipUivs TXP_MR_10Gz FEC ° 4& ZiA 1+1 15454-10T-L1-xx.y=
YE -"O¢
AdipUivs TXP_MR_10Gz FEC s <& ZTA 1+1 15454-10T-L1-xx.y=
YE -"O¢
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cas §"A

B-6 10GE LAN PHY ¢10.3 Ghps £

i»"NE p »0 |8"A » O ¢» O avh ID
AdipUivs TXP_MR_10E_CS"‘| «& ZiA  1+1 15454-10E-L1-C=¢ C 1T A £
TXP_MR_10E_lz EFEC ® YE -"O¢ 15454-10E-L1-L=¢ L 1T A£
AdipUivs TXP_MR_10E_CS"‘| «& ZiA  1+1 15454-10E-L1-C=¢ C 1T A £
TXP_MR_10E_lz FEC YE -"O¢ 15454-10E-L1-L=¢ L 1T A£
AdipUivs TXP_MR_10E_CS"| «& ZiA  1+1 15454-10E-L1-C=¢ C 1T A £
TXP_MR_10E Lz FEC s~ YE -"O¢ 15454-10E-L1-L=¢ L 1T A£
AdipUivs TXP_MR_10Ez EFEC ° q& ZiA 1+1 15454-10E-L1-C=¢ C 1T A £
YE -"O¢ 15454-10E-L1-L=¢ L 1T A£
AdipUiv, TXP_MR_10Ez FEC ° q4& 77T A 1+1 15454-10E-L1-C=¢ C 1T A £
YE -"O¢ 15454-10E-L1-L=¢ L 1T A£
AdipUivs TXP_MR_10EZFEC s <& ZTA 1+1 15454-10E-L1-C=¢ C 1TA £
YE -"O¢ 15454-10E-L1-L=¢ L 1T A£
AdipUivs TXP_MR_10Gz FEC ° 4& ZiA 1+1 15454-10T-L1-xx.y=
YE -"O¢
AdipUivs TXP_MR_10Gz FEC s <& ZTA 1+1 15454-10T-L1-xx.y=
YE -"O¢
T B-7 GE ¢ 1.25Gbps £
i»"NE p »0 |8"A » O ¢» O avh ID
AdipUiv MXP_MR_2.5G «& ziA  1+1 15454-DM-L1-xx.y=¢ £- ¢ £
MXPP_MR_2.5G YE -"O¢ 15454-DMP-L1-xx.y=¢ - ¢ £
«Ne T p ¢%A
AdipUivs MXP_MR_10DMEz EFEC®  «& ZiA 1+1 15454-10DME-C=¢ C 1T1A £
YE -"O¢ 15454-10DME-L=¢ L 1T1A £
AdipUivs MXP_MR_10DMEz FEC ° q& ZiA 1+1 15454-10DME-C=¢ C 1T1A £
YE -"O¢ 15454-10DME-L=¢ L 1T1A £
AdipUivs MXP_MR_10DMEz FEC s° <& ZTA 1+1 15454-10DME-C=¢ C 1T1A £
YE -"O¢ 15454-10DME-L=¢ L 1TA £
AdipUivs TXP_MR_2.5G «& ZiA  1+1 15454-MR-L1-xx.y=¢ 1 - ¢ £
TXPP_MR_2.5Gz FEC © YE -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne 1 n ¢ %A
AdipUivs TXP_MR_2.5G «& 2iA  1+1 15454-MR-L1-xx.y=¢ 1 - ¢ £
TXPP_MR 25 FECs" YE -"0Og¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne T p ¢%A
0&a O¢ GE DWDM GBIC «d& ZTA  1+1 15454-GBIC-xx.y=
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| ¢cas §"A » O
~ B-8 NepuA "+E¢A¢ 100 Mbps £
i»"NE p »0 |8"A » O ¢t» O avh ID
AdipUivs TXP_MR_2.5G «8 ZiA  1+1 15454-MR-L1-xx.y=¢ ¥ - ¢ £
TXPP_MR_2.5G 2R YE -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne 1 VEPEZY.\
T B-9 FC-10G ¢ 10.5 Gbps £
i»"NE p »0 |8"A » O ¢» O a¥h ID
AdipUiv, TXP_MR_10E_CS | «d ziA  1+1 15454-10E-L1-C=¢ C ITA £
o
TXP_MR_10E 2z EFEC YE -"O¢ 15454-10E-L1-L=¢L 1iA£
AdipUiv, TXP_MR_10E_CS | «d ziA  1+1 15454-10E-L1-C=¢ C ITA £
o
TXP_MR_10E Lz FEC YE -"O¢ 15454-10E-L1-L=¢L 1iA£
AdipUivs TXP_MR_10E_CS'| «d ziA  1+1 15454-10E-L1-C=¢ C ITA £
TXP_MR_10E Lz FEC s YE -"O¢ 15454-10E-L1-L=¢L 1iA£
AdipUiv, TXP_MR_10Ez EFEC °© & ZTA 1+1 15454-10E-L1-C=¢ C ITA £
YE -"O¢ 15454-10E-L1-L=¢L 1iA£
AdipUiv, TXP_MR_10Ez FEC ° & ZTA 1+1 15454-10E-L1-C=¢ C ITA £
Y E -"O¢ 15454-10E-L1-L=¢L 1iA£
AdipUivs TXP_MR_10EzFEC s~ <& ZTA 1+1 15454-10E-L1-C=¢ C ITA £
YE -"O¢ 15454-10E-L1-L=¢L 1iA£
T B-10  FC-4G ¢4.25 Gbps £
i»"NE p »0 |8"A » O ¢t» O avh ID
AdipUivs MXP_MR_10DMEz EFEC® «& ZiA 1+1 15454-10DME-C=¢ C 1i1A £
YE -"O¢ 15454-10DME-L=¢ L 1TA£
AdipUivs MXP_MR_10DMEz FEC ° «8 ZTA 1+1 15454-10DME-C=¢ C 1T1A £
YE -"O¢ 15454-10DME-L=¢ L 1TA£
AdipUivs MXP_MR_10DMEzFECs"~ & ZiA 1+1 15454-10DME-C=¢ C 1i1A £
YE -"O¢ 15454-10DME-L=¢ L 1TA£
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cas §"A » O
[ |
T B-11  FC-2G ¢2.125 Gbps £
i»"NE p »0 |8"A » O ¢t» O avh ID
AdipUivs MXP_MR_2.5G «8 ZiA  1+1 15454-DM-L1-xx.y=¢ £ - ¢ £
MXPP_MR_2.5G YE -"O¢ 15454-DMP-L1-xx.y=¢ - ¢ £
«Ne 1 VEPEZY.\
AdipUivs MXP_MR_10DMEz EFEC° & ZiA 1+1 15454-10DME-C=¢ C 1TA £
YE -"O¢ 15454-10DME-L=¢ L 1TA£
AdipUiv, MXP_MR_10DMEz FEC ° & ZTA 1+1 15454-10DME-C=¢ C 1TA £
YE -"O¢ 15454-10DME-L=¢ L 1TA£
AdipUiv, MXP_MR_10DMEzFEC s~ & ZziA 1+1 15454-10DME-C=¢ C 1TA £
YE -"O¢ 15454-10DME-L=¢ L 1TA£
AdipUiv, TXP_MR_2.5G «8 ZiA 141 15454-MR-L1-xx.y=¢ ¥ - ¢ £
TXPP_MR_2.5G FEC © YE -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne 1 U ¢ %A
AdipUivs TXP_MR_2.5G «8 ziA  1+1 15454-MR-L1-xx.y=¢ £ - ¢ £
TXPP_MR 2.5 FECs" YE -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne i n %A
T B-12  FC-1G ¢1.062 Ghps £
i»"NE p »0 |8"A » O ¢t» O avh ID
AdipUiv, MXP_MR_2.5G «8 ZiA 141 15454-DM-L1-xx.y=¢ £ - ¢ £
MXPP_MR_2.5G YE -"O¢ 15454-DMP-L1-xx.y=¢ - ¢ £
«Ne 1 U ¢ %A
AdipUivs MXP_MR_10DMEzEFEC® «& ZiA 1+1 15454-10DME-C=¢ C 1i1A £
YE -"O¢ 15454-10DME-L=¢ L 1TA£
AdipUivs MXP_MR_10DMEzFEC®° & ZiA 1+1 15454-10DME-C=¢ C 1i1A £
YE -"O¢ 15454-10DME-L=¢ L 1TA£
AdipUivs MXP_MR_10DMEzFEC s~ & ZiA 1+1 15454-10DME-C=¢ C 1i1A £
YE -"O¢ 15454-10DME-L=¢ L 1TA£
AdipUivs TXP_MR_2.5G «8 zZiA  1+1 15454-MR-L1-xx.y=¢ £ - ¢ £
TXPP_MR_2.5Gz FEC © YE -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne i n ¢ %A
AdipUivs TXP_MR_2.5G «8 ZiA  1+1 15454-MR-L1-xx.y=¢ £ - ¢ £
TXPP_MR 25 FECs" YE -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne 1 V7Y
I A
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| ¢cas §"A » O
[ |
T B-13  FICON-2G ¢2.125 Ghps £
i»"NE p »0 |8"A » O ¢t» O avh ID
AdipUivs MXP_MR_2.5G «8 ZiA  1+1 15454-DM-L1-xx.y=¢ £ - ¢ £
MXPP_MR_2.5G YE -"O¢ 15454-DMP-L1-xx.y=¢ - ¢ £
«Ne 1 VEPEZY.\
AdipUivs MXP_MR_10DMEz EFEC° & ZiA 1+1 15454-10DME-C=¢ C 1TA £
YE -"O¢ 15454-10DME-L=¢ L 1TA£
AdipUiv, MXP_MR_10DMEz FEC ° & ZTA 1+1 15454-10DME-C=¢ C 1TA £
YE -"O¢ 15454-10DME-L=¢ L 1TA£
AdipUiv, MXP_MR_10DMEzFEC s~ & ZziA 1+1 15454-10DME-C=¢ C 1TA £
YE -"O¢ 15454-10DME-L=¢ L 1TA£
AdipUiv, TXP_MR_2.5G «8 ZiA 141 15454-MR-L1-xx.y=¢ ¥ - ¢ £
TXPP_MR_2.5G FEC © YE -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne 1 U ¢ %A
AdipUivs TXP_MR_2.5G «8 ziA  1+1 15454-MR-L1-xx.y=¢ £ - ¢ £
TXPP_MR 2.5 FECs" YE -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne i n %A
T B-14  FICON-1G ¢ 1.062 Gbps £
i»"NE p »0 |8"A » O ¢t» O avh ID
AdipUiv, MXP_MR_2.5G «8 ZiA 141 15454-DM-L1-xx.y=¢ £ - ¢ £
MXPP_MR_2.5G YE -"O¢ 15454-DMP-L1-xx.y=¢ - ¢ £
«Ne 1 U ¢ %A
AdipUivs MXP_MR_10DMEzEFEC® «& ZiA 1+1 15454-10DME-C=¢ C 1i1A £
YE -"O¢ 15454-10DME-L=¢ L 1TA£
AdipUivs MXP_MR_10DMEzFEC®° & ZiA 1+1 15454-10DME-C=¢ C 1i1A £
YE -"O¢ 15454-10DME-L=¢ L 1TA£
AdipUivs MXP_MR_10DMEzFEC s~ & ZiA 1+1 15454-10DME-C=¢ C 1i1A £
YE -"Og¢ 15454-10DME-L=¢ L 1TA£
AdipUivs TXP_MR_2.5G «8 zZiA  1+1 15454-MR-L1-xx.y=¢ 1 - ¢ £
TXPP_MR_2.5Gz FEC © YE -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne i n ¢ %A
AdipUivs TXP_MR_2.5G «8 ZiA  1+1 15454-MR-L1-xx.y=¢ £ - ¢ £
TXPP_MR 25 FECs" YE -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne 1 VEPAZY.\
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cas §"A » O
|
~ B-15 ESCON ¢ 200 Mbps £
i»"NE p »0 |8"A » O ¢t» O avh ID
A&dipUiv, MXP_MR_2.5G «& ZTA 1+1 15454-DM-L1-xx.y=¢C £ - ¢ £
MXPP_MR_2.5G YE -"O¢ 15454-DMP-L1-xx.y=¢ - ¢ £
«Ne 1 VEPEZY.\
A&ipuUivs TXP_MR_2.5G «& ZiA 141 15454-MR-L1-xx.y=¢ f - ¢ £
TXPP_MR_2.5G 2R YE -"0O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne 1 VEPRZY.
~ B-16 ISC-Compact ¢ 1.062 Gbps £
i»"NE p »0 |8"A » O ¢t» O avh ID
A&dipUiv, TXP_MR_25zFECs” <a ZTA 1+1 15454-MR-L1-xx.y=¢ £ -¢C £
15454-MRP-L1-xx.y=¢ - ¢ £
A&dipUiv, MXP_MR_10DMEzEFEC®° & ZiA 1+1 15454-10DME-C$ C 1T A £
15454-10DME-L=¢t L 1TA £
A&dipUiv, MXP_MR_10DMEz FEC ° & ZiA 1+1 15454-10DME-C$ C 1T A £
15454-10DME-L=¢t L 1TA £
A&dipUiv, MXP_MR_10DMEz FEC s <& ZTA 1+1 15454-10DME-C$ C 1T A £
15454-10DME-L=¢t L 1TA £
- B-17 ISC-Peer 2R
i»"NE p »0 |8"A » O ¢t» O avh ID
A&ipuUivs TXP_MR_2.5G 2R «& ZiA 141 15454-MR-L1-xx.y= - ¢ £
15454-MRP-L1-xx.y=¢ - ¢ £
" B-18 ISC-3 Peer-1G ¢ 1.062 Gbps £
i»"NE p »0 |8"A » O ¢» O a¥h ID
A&ipuUivs MXP_MR_10DMEz EFEC°® ¢& ZiA 1+1 15454-10DME-C=¢ C 1iA £
YE -"O¢ 15454-10DME-L=¢ L 1iA £
A&ipuUivs MXP_MR_10DMEz FEC®°  ¢& ZiA 1+1 15454-10DME-C=¢ C 1iA £
YE -"O¢ 15454-10DME-L=¢ L 1iA £
A&iuUivs MXP_MR_10DMEz FEC s’ &4& 2ziA 1+1 15454-10DME-C=¢ C 1iA £
YE -"O¢ 15454-10DME-L=¢ L 1iA £
Cisco MetroPlanner DVDM ! O @”3 47 A
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| caB §"A » O
[ |
T B-19  ISC-3 Peer-2G ¢2.125 Gbps £
i»"NE p »0 |8"A » O ¢t» O avh ID
AdipUivs MXP_MR_10DMEzEFEC® «& ZiA 1+1 15454-10DME-C=¢ C 1T1A £
YE -"O¢ 15454-10DME-L=¢ L 1T1A£
AdipUivs MXP_MR_10DMEzFEC®° ¢ & ZiA 1+1 15454-10DME-C=¢t C 1T1A £
YE -"O¢ 15454-10DME-L=¢ L 1T1A£
AdipUivs MXP_MR_10DMEzFECs™~ & ZiA 1+1 15454-10DME-C=¢ C 1T1A £
YE -"O¢ 15454-10DME-L=¢ L 1T1A£
~ B-20 Sysplex ETR ¢ 8 Mpbs £
i»"NE p »0 |8"A » O ¢t» O avh ID
AdipUivs TXP_MR_2.5G 2R «& ziA 141 15454-MR-L1-xx.y=¢ $- ¢ £
15454-MRP-L1-xx.y=¢ - ¢ £
T B-21 Sysplex CLO ¢ 8 Mpbs £
i»"NE H » O §"A » O ¢» O avh ID
AdipUivs TXP_MR_2.5G 2R «d ziA  1+1 15454-MR-L1-xx.y=¢ $- ¢ £
15454-MRP-L1-xx.y=¢ - ¢ £
T B-22 SDI
i»"NE H » 0O §"A » O ¢» O avh ID
AdipUivs TXP_MR_2.5G «& ziA 141 15454-MR-L1-xx.y=¢ 1 - ¢ £
TXPP_MR_2.5G 2R Y E -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne i U ¢ %A
T B-23  DVB-ASI
i»"NE H » O §"A » O ¢t» O avh ID
AdipUivs TXP_MR_2.5G TXPP_MR_2.5G 2R| «& ziA  1+1 15454-MR-L1-xx.y=¢ - ¢ £
YE -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne 1 W %A
T B-24 D1 TA'¢ 270 Mbps £
i»"NE Tt » 0 §"A » O ¢» O avh ID
AdipUivs TXP_MR_2.5G TXPP_MR_2.5G 2R| «& ZiA  1+1 15454-MR-L1-xx.y=¢ 1 - ¢ £
YE -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne i n ¢ %A
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cas §"A » O |
|
~ B-25 HDTV ¢ 1.48 Gbps £
i»"NE p »0 |8"A » O ¢» O av% ID
AdipUivs TXP_MR_2.5G TXPP_MR_2.5G 2R| «& ZiA 1+1 15454-MR-L1-xx.y=¢ £ - ¢ £
YE -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne 1 n o %A
" B-26 DV-6000 ¢ 2.38 Ghps £
i»"NE p »0 |8"A » O ¢» O a¥h ID
AdipUivs TXP_MR_2.5G TXPP_MR _2.5G 2R| «& ziA  1+1 15454-MR-L1-xx.y=¢ f - ¢ £
YE -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne | TRPEZY
- B-27 2R Any Rate
i»"NE p »0 |8”A » O ¢» O av% ID
AdipUivs TXP_MR_2.5G TXPP_MR_2.5G 2R| «& ZiA 1+1 15454-MR-L1-xx.y=¢ £ - ¢ £
YE -"O¢ 15454-MRP-L1-xx.y=¢ - ¢ £
«Ne 1 n ¢ %A
" B-28 ONS 15530 2.5G ITU-T
i»"NE p »0 |8"A » O ¢» O a¥h ID
TXP MR MM TXP «& ZTA 1+1 15530-TSP1-xx2T MM f-¢ £
MR SM TXP «Ne 1 n o %A 15530-TSP1-xx22 SM f-¢ £
MRMMTXPzpuOae ¢ »° 15530-TSP1-xx1T MM -¢ £
MRSMTXPzuOa ¢ »° 15530-TSP1-xx12 SM - ¢ £
LC 25Gbpsz-&®"341 «d& zZiA 1+1 15530-ITU3-xx20¢ £ - ¢ £
25Gbpsz-a&®"34iz «Ne 1 U ¢ %A 15530-ITU3-xx10¢ - ¢ £
K Oa¢»o
~ B-29 ONS 15530 10G ITU-T
i»"NE p »0 |8"A » O ¢» O a¥h ID
LC 10 Gbpsz-ae®"34ai «d zZiA 1+1 15530-ITU2-xx20¢ £ - ¢ £
10 Gbpsz-a®"34iz «Ne 1 U ¢ %A 15530-ITU2-xx10¢ - ¢ £
nOa¢ »°
MXP A» U¢«pUivs «d ZTA 1+1 15530-MSMP-xx22t 1 - ¢ £
A"» U¢i«pUiYaz «Ne T p ¢®A 15530-MSMP-xx12 - ¢ £

HOa¢ »°
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APPENDIX C

\wWC&txz Cisco MetroPlannefuAU Y¢-""we°at T C-1£5GL ib{
T c1 od" Y¢-"
\ » O 0" Y¢-oo
A&aNY ¢« Ugbi- |Wavelength {0} may require additional ASE filtering.p © {0} t ASE
NYc»aei-wWACUZAE
A&aNY¢« Ugbi-  |50GHz scalability is supported only with {0} design rui&® GHz w 1 -
dlee AYU£U"Are"wx {0} wWf-¢"ctv’stbE
A&NY ¢« UgbDi- |The network is broken: please connect all the sites togétlieg, A & ” «
U~.."*oM"wpzb,ow+ A>€ "oXi"ME£
A&NY ¢« U¢gDi- |The traffic model is empty: please add at least one service reqdest.
NY¢« PAgUiswpz 1mZiwx"TuA{>8C oXi
"ME
A&NY ¢« UgbDi- |Number of Add/Drop nodes exceeded the maximum ({0}) allowed in the
network.¢ 102 O [add/dropl E"A:UE ;A& «w+07G:
{0} >Oa oMthb£E
A&NY¢« Ugbi-~ |ONS15454 DWDM platform supports up to {0} non-pass-though sites.
¢ ONS15454 DWDMO & ¢ AN¥"UU+U”Ab " tipuc” +
Ax7G {0} pbE
A&NY ¢« UgbDi- |Line+ sites can't support DMX-O units due to layout constrainés. 7 ¢
AWMyU|%p Line+t+ Ax DMX-O +”>2U"ApVide£
A&NY ¢« UgbDi- |Line+ sites can't support Individual Shelf with DCC chain option due to layout
constraintg.¢ a¢AwMyUjYpz Line+ + Ax Individual Shelf
with DCC chain! 034i>+U"ApVidoe £
A&NY ¢« U¢gDi- |[Client{0}is not available in the equipment ligt= "ae pAt« & 27
A{0} UK“tdeef
AaNY¢« Ugbi-  |Anyto Any traffic is not supported by {0} rulesAny to Any A&RN Y ¢ «
x {0} w¢’gcpxzU”Aretdeef
A&NY ¢« UgDi- |Any to Any traffic requires ROADM units but ROADM is not allowed by
restricted equipment list. Any to Any AAN Y ¢ «tx  ROADM +"U
ZApbUz ROADM xMv=+"apAt'lo—;pVidet
A&NY ¢« UgbDi- |Can'tplace ROADM units in site {0} to support Any to Any traffict A
{0} t ROADM +”> "“0 Anyto Any AR Y ¢ «>+U”Ab
"\gxpVideef

[ oL-10358-01-J
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Ca&C 3pAU Y¢ " |

~C1 gd” Y¢o"'¢ VE
Yc.’_n’ » O Jau Yc.’_u’
A&NY ¢« U¢gDi- |ROADM configuration is not allowed by restricted equipmentligty + "

aphAtilo ROADM IRUY S etde£

A&NY ¢« UgDi-  |Mux Demux configuration is not allowed by restricted equipmentdlist.v
+"epAt'lo MUX/Demux IRUY S’'efdce £

A&NY ¢« UgbDi- |Only ROADM configuration is allowed with selected design ruesR

hf-c'cpYS e"wx ROADM iRiZpb£

A&NY ¢« U¢gbDi- |ROADM is not allowed by the selected design ruiles.R *hf-¢”¢

px ROADM xYS’'sfdee£

A&NY¢« UgbDi-~ |ROADM-O is notallowed with L band:L i1iApx ROADM-O xVY S

"efdeef

A&NY ¢« UgbDi- |Linet+ or Terminal+ site topologies are not allowed by selected design rules.
¢-Rhf-¢"¢cpxz Line+ thx Terminal++ A AUé"”
xYS'etdoef

A&NY ¢« U¢gDi- |Line+ or Terminal+ site topologies require ROADM units but ROADM is not
allowed by restricted equipment ligtLine+ $ hx Terminal++ A AU

é "tx ROADM ="UZApbUz ROADM xMv+"a& puAt
‘lo—;pVide£

A&NY ¢« UgDi- |OADM unit{0}definedin {1} is not allowed by restricted equipmentdi§L}

p [~eh OADM +” {0} xzMv+"aepAt'lo—;pVi
dee £

AadNY¢« Ugbi- |Cantfind a valid aggregating cliet. ® s7Z - ®”AYi- «8
ZIAUK"“tdee£

A Ye¢«w Uegbi- |Cantfindavalidclientt ®s«& 2TAUK“tdee£

A&NY ¢« U¢gDi- |[Client {0} can't be tuned on wavelength {8} & Z7iA {0y »pd {1}
piitb"\gxpVidcef

A&NY ¢« U¢gbDi- |Forced wavelength {0} is outside selected bah8M & ;*+hp O {0}
X" RAh3-T'ZeoMZIb£E

A&NY ¢« U¢gDi- |Forced client {0} can't be tuned on selected b&n@M & ;*+h « &

5iA {0} >-RA«h3-plitb"\qxpVideef

A&NY ¢« U¢gDi- |Interface Type {0} is not supported by the selected Design Ruléis»
NEu » O {0} xz=R hf-¢"¢cpxxU"Aretdoef

A&NY ¢« U¢gbDi- |Add/Drop notavailable insite {8+ A {0} pxu0a® [add/drop]>
—;pVideef

AaNY¢« Ugbi-  |Maximum wavelength re-usage reached for ITU channet{TlJ %R E¢
{0 w7GpO6b;ta’ t hE

AaNY¢« Ugbi- |Allsolutions exceed {0} wavelengthsb ,owlzae 4”3 4i>0"d

"q {0} wpO:>OQ1tb£ {®C.1.1y Wavelength Exceeded p.C-8£

>€° 0 XiMM{
A&aNY¢« Ug¢gbi- |The anti ASE option is available only in sites with add/drop capabslati
ASE !032di>—;pV wxziu0ad [add/drop] ; 6 WK ” +
Atv’etib£E
A&NY¢s« Ugbi- |Morethan one anti ASE site was selected.:w antiASE+ AU-R
NefhE
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| cac

SuAU0 Yv¢- "

od"”

Yé-"" ¢ VE

»

o

Jau Yc.’_u’

ANY ¢ «

UeDim

No specific anti-ASE node is requiréar this traffic matrix requirement.\
WAANY « UAse«pAEwOUz > w ant-ASEE”Ax/EA
pb£

AANY ¢ «

Uebim

Protected services are not allowed with linear netwbeksC 7 E ¢ Aé”
«px-¢+x"Tp>—;pVidoe £

AANY ¢ «

UeDim

In a network with hub nodes protected services are allowed only between hub
sitest EOQO E"AWK"E¢ A «p-¢+"Tp>—;pV”w
XEO £ A iZpbE

AANY ¢ «

U(;D'I'ﬂ

Invalid routing (out of network boundar@) A®s¢”AYi-'E¢ A
8"«¥,728 £®C.1.2yInvalid Routing€¢ p.C-9£>€° 0 Xi*M{

AANY ¢ «

UeDim

Can't route service with optical bypass in {0J0} w!OAY§¢ 1 i
pupx+"iu>c”AYi-pVideef

AANY ¢ «

UeDim

Can't find alternate route due to multiple HUB nodes along thedpbyh.
tEO E"AUG:K"WpE8¢"A>UZpVidoe£{ ®C.1.3
Cannot Find Alternate Routé& p.C-9£ >€° 0 Xi*M{

AANY ¢ «

U(;D'I'ﬂ

Can't route service through HUB node 0E O E”A {0} & pxz”
fu>¢c”AYi-pVide£{ ®C.1.4yCannot Route Service
¢p.C-10£ >€° 0 XiAM{

AANY ¢ «

U(;D'I'ﬂ

Overlapped services assigned to the same wavelghgithap Ot O 6 b
"+"TpUA“po’+ oMt bE{ ®C.1.5y Overlapped Services
Assigned to the Same Wavelengthp.C-11£ >€° 0 Xi"M{

AANY ¢ «

U(;D'I'ﬂ

Protected services assigned to the same wavelgntfta p O t- ¢ +”
THUA“po’soMIbE{ ®C.1.6y Protected Services Assigned to
the Same Wavelengtft p.C-11£ >€° 0 Xi*M{

AANY ¢ «

UeDim

Can't route service due to add drop equipment constrairiisO a O
[add/drop] = WMy U|j¥%px”Tu>¢”AYi-pVide£{

®C.1.7y Cannot Route Service Because of Add/Drop ConstrahsC-12£
»€° 0 XiMM{

AANY ¢ «

U(;D'I'ﬂ

Design requires forcing a site as ROADM or Full Mux/Demux but no valid site
wasfoundt f-iz +* A>§M$t ROADM 1 hx Full Mux/Demux
t'sZeys“tdeUz ®s+ AUK“tde£

AANY ¢ «

U(;D'I'ﬂ

Design requires forcing site as ROADM or Full Mux/Demux: remove
equipment constraint.f -1z+ A>§M$t ROADM fhx Full
Mux/Demuxt sZeys'sMwpz="wMy>rt oXi”

ME

yi+wzc°ae U

In {0}, can’t force a demux if it is not supported by site typ€0} pxz+
A » OpzU"AresMOUtx Demux>8M&;pVid
(o33

yi+wzc°ae U

In {0}, can’t force an inline attenuator if it is not supported by site t¢{6}
pxzx A » OpxU”"AreoMsMOUutx 74 in0
+>8M&;pVidef

yi+wzc°ae U

In {0}, can’t force an inline attenuator because of presence of OADMs in the
other side¢ {0} pxzSO0 t OADM U Ob”wpz 14 Tn
0+>8M&;pVideft
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Ca&C 3pAU Y¢ " |

~C1 gd” Y¢o"'¢ VE

Yc.’_n’ » O Jau Yc.’_u’

yi+wzc°ae U Invalid forcing in amplifier node of {0} because of Pass-through site forcing.
Cippg” + AWEMU|j%pz {0} wyi+E”AtSZ"8M
& UA®pbE

yi+wzc°ae U

In {0}, can’t force unplaced OSC card in a non Pass-througltg@g. p x z
tippcg” + AtSZ” 0OSC8&"Aw "rt>8Mb"\q
xpVideef

yi+wzc°ae U

In {0}, can’t force OSCM without an amplifier forcet{0} pxzyi+>
8§M&; sMp OSCM>8M&;b"\gxpVidet

yi+wzc°ae U

Can't force power output or tilt in {0} without the related amplifier for¢ed.
Eb"yi+>8§M&; sMpz {0} pZ—thx V>8§M&;
b"\gxpVidet

yi+wzc°ae U

Cannot force input attenuator in {1} without the related amplifier for¢ed.
Eb"yi+>8M&; sMpz {1} pO—nO0+>8§M&;b"
\gxpVidoe£f

yi+wzc°ae U

Can't force DCUs in {0} without forcing an amplifier that supports them.
CDCU>+xU”Ab"yi+>8M&; sMpz {0} pDCU>8&8M
&;b"\gxpVidoe£{ ®C.2.1yIncompatible DCUs (C-Band)
¢p.C-13£ >€° 0 Xi"M{

yi+wzc°ae U

Incompatible types for DCU couple in {0}0} px DCU Ozw» OU
Al"’oMtb£ {®C.2.1y Incompatible DCUs (C-Band)t p.C-13£ > €
°ToXirMM{

yi+wzc°a U

Incompatible dispersion modules in {4{0} wiu,bp " a"¢cU&U"
fdoe £{®C.2.1y Incompatible DCUs (C-Band} p.C-13£ >€° "0 X
i"M {

yi+wzc°ae U

In {0}, MMU presence requires OPT-AMP-L forcing in bst and pre position.
¢{0} pxzMMU U Ob”Ouz bst S‘| pre U 3&ip
OPT-AMP-L>8M&;b"ZAUK"1b£E {®C.2.2y MMU Does Not

Have Correct Amplifier (L-Band)¢ p.C-13£ >€° 0 Xi*M{

yi+wzc°ae U

In {0}, MMU presence requires OPT-PRE and OPT-BST-E forcin@®} p
xzZMMU U Ob”Ouz OPT-PRES‘| OPT-BST-E>§M&;b
"ZAUK"“Tb£E{ ®C.2.3y MMU Does Not Have Correct Amplifier
(C-Band) ¢p.C-14E£ >€° 0 Xi"M{

yi+wzc°ae U

In {0}, output power is out of limits of amplifier selectet{0} pxzZ —
U-R"ehyi+wvS>OQoMzIb£E {®C.2.4y Output Power or
Tilt are Out of Range¢ p.C-14£ >€° 0 Xi*"M{

yi+wzc°ae U

In {0}, amplifier tilt is out of limits.¢ {0} pxzyi+w VU+OVS
Zpb £ {®C.2.4y Output Power or Tilt are Out of Rangé p.C-14£ > €
°ToXirM{

yi+wzc°ae U

Couple between {1} and {2} has an invalid value in {@{0} pxz {1} q
{22 wOoOw<UA®pb£{ ®C.2.5yInvalid Fiber Values, Types, and
Loss Values ¢ p.C-15£ >€° o Xi*M{

yi+wzc°ae U

Couple between {0} and {1} is of invalid type{0} q {1} WOUA®s
» O pb£{ ®C.2.5y Invalid Fiber Values, Types, and Loss Values
¢p.C-15£ >€° o XirM{
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| cac =pAU Y¢- "

- Cc1 0d”

Yé-"" ¢ VE

Yc.’_n’ » O

Jau Yc.’_u’

yi+wzc°ae U

Fibre between {1} and {2} has an invalid value in {8}{0} pxz {1} ¢
{22 w«Ne I<UA®pbE {®C.2.5y Invalid Fiber Values, Types,
and Loss Valuest p.C-15£ >€° 0 Xi*M{

yi+wzc°ae U

Fibre between {0} and {1} has SOL total loss greater than EOL totat k@3s.
q {1} w«RNe ixz SOL7i &eU EOLT &>isloM*

b £{®C.2.5y Invalid Fiber Values, Types, and Loss Valué®.C-15£ > €
°ToXirM{

yi+wzc°ae U

Can't respect forcing on {0} attenuator (on channel {1}) in {2} {3} {¢}2} z
{3} z{4} tSMoz [ %LRE¢ {1} iw }{0} wnO+t0Ob”"8§M&
;> OpVide£ { No A ports are availablg. i0a O [add/drop]
U”Ax—;pVideoe£{ ®C.2.6yAttenuator Forcing Not Allowed
¢p.C-15£ >€° 0 Xi"M{

yi+wzc°ae U

A {0} attenuator (on channel {1}) in {2} {3} {4} was present, but A/D ports
on this channel are no longer availai$i¢2} z {3} z{4} tSMo%RE¢

{1} itno+ {0} U O tbUz\w%REg¢wi0al
[add/drop] U Axbpt—;pVsXsloMitbg£({ ®C.2.7
Unavailable Add/Drop Channelg p.C-16£ >€° "0 Xi*M{

yi+wzc°ae U

Tilt forced on {0} in {1} {2} {3} when no-tilt design option is selectd@d1} z
{2} {3} px no-tilt design! O3&8iU-R"eoMsU’z {0} t
VUEM&;"*oMtb£f  {®C.2.8y Tilt Forced When No Tilt Design is
Selected ¢ p.C-16£ >€° "0 Xi*"M{

yi+wzc°ae U

Can’t change DMX with DMX-O as needed in {1} because user fofcany.
2Ww8M&;Uj¥%pz {1} pzAs DMX T’ DMX-O w!EUp
V1dee £ {®C.2.9y Cannot Replace 32-DMX with 32DMX-0¢ p.C-17£
>€° 0 XiMM{

yi+wzc°ae U

on OPT-BST positiod.OPT-BSTU " 240t b 30 arzw
§M&:Uj¥%pz {0} z{1} z{2} W% RE¢ (é"U<vpé¢a
x"cApbE

yi+wzc°ae U

In {0}, {1} is working in an invalid mod&.{0} px {1} UA®spP”Ap
"A"“oMiIb£{ ®C.2.10y Preamplifier Working in Invalid Mode
¢p.C-18E£ >€° o Xi*"M{

yi+wzc°ae U

In {0}, {1} is working with a gain of {2} dBm: this is too low. {0} p x {1}
U{2}dBm wyipp """ oMtbUz\epxybWi3Ib£({
®C.2.11y Gain Too Low for an Amplifier¢ p.C-18£>€° 0 Xi*M{

yi+wzc°ae U

In {0}, {1} will be work (in EOL condition) with a gain of {2} dBm: this is
too low.¢ {0} px¢ EOL UEWE {1} U{2}dBm wyipp " o
MtfbUz\epxybW3Fb£{ ®C.2.11y Gain Too Low for an
Amplifier "¢ p.C-18£ >€° "0 Xi*"M{

yi+wzc°ae U

In {0}, {1} is working with a gain of {2} dBm: this is too high{0} px {1}
U{2}dBm wyipp " * " oMtbUz\epxdbWi%thbE({
®C.2.12y Gain Too High for an Amplifiert p.C-19£>€° 0 Xi*M{

yi+wzc°ae U

In {0}, {1} will be work (in EOL condition) with a gain of {2} dBm: this is too
high.¢ {0} px [EOL UEw ]{1} U{2}dBm wyipp "~ oMt
bUz\epxdbWi1b£ {®C.2.12y Gain Too High for an Amplifier
¢p.C-19£ >€° o Xir"M{
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- Cc1 0d”

Yé-"" ¢ VE

Yc.’_n’ » O

yi+wzc°ae U

08t Yoo
In {0}, {1} cannot respect user forcing.{0} pxz {1} xa"2w8M&
;> OpVidoe£ {®C.2.13y User Forcing Overriddent p.C-19£ >
€° o Xir"M{

yi+wzc°ae U

In {0}, {1} cannot respect user forcing due to {#{0} pxz {1} x {2} U
jYapa"2w8M&;> OpVidme£{ ®C.2.13y User Forcing
Overridden ¢ p.C-19£ >€° 0 Xi*M{

yi+wzc°ae U

Unsupported configuration due to excessive number of amplifiers (max {0} per
directions)¢ yi+w:U bW~ [1 M2p7G {0}]] hStxU"A
NesMIRtsloMtbE({ ®C.2.14y Unsupported Configuration
Cp.C-20E>€° o Xi"M{

yi+wzc°ae U

Unsupported configuration due to excessive number of OSC regen sites (max
{0}).¢0SC6\+ Aw:U bWwW"” [7G{0}] wptU"Anres
MIRtsloMtb£E {®C.2.14y Unsupported Configuratior¢ p.C-20£

>€° 0 XiMM{

yi+wzc°ae U

In {0}, channel power is near the fail threshad{0} px%RE¢ (&~
UEepeée¢g3ax"¢cAtUnMoMiEbE{  ®C.2.15y Channel
Power Near the Fail Threshold p.C-20£ >€° 0 Xi*M{

yi+wzc°ae U

In {0}, channel power is below the fail threshofD} px%RE¢ (é&”
UEepeé¢c3ax"cAr<sloMibeE( ®C.2.16y Channel
Power Below the Fail Threshold p.C-20£ >€° 0 Xi"M{

yi+wzc°ae U

In {0}, OSC channel power is near the fail thresholfl} px OSC %R E
¢ [é”"UEspeée¢g3ax"¢cAtUnMoMEbE(] ®C.2.15
Channel Power Near the Fail Thresholdp.C-20£ >€° "0 Xi*M{

yi+wzc°ae U

In {0}, OSC channel power is below the fail threshdld0} px OSC ¥R
Ec 6"UEepeé¢3ax"cA>s<sloMtb£({ ®C.2.17
OSC Channel Power Below the Fail Threshatg.C-21£ >€° " 0 X

N M{

yi+wzc°ae U

Network unfeasible due to OSC chan®eDSC R E¢U|jY%pE ¢ A
8"«>TqpVideet {®C.2.17y OSC Channel Power Below the Fail
Threshold ¢ p.C-21£ >€° 0 Xi*"M{

yi+wzc°ae U

Try to unfreeze amplifier or dcus in site {0}, interface {1}, {2} positiorx
A{0zi»"NE p {1} w{2} we”tK"yi+1hx DCU
WZA>rtf o"oXi"ME

yi+wzc°ae U

Transmission error.Please contact custom degigi.c " pb{§
»Uf-tZ«-u oXi*"ME

yi+wzc°ae U

Transmission error on channel {0}.Please contact custom dd@sigi E ¢
{0} w;ued"pb{8u»Uf-tz«-u oXi*M£

yi+wzc°ae U

Excessive ROADM crossTalk penalty on channel {0}.Try to lower the output
power of the preamplifier in the Roadm site in which the failed channels are
added¢ % BE¢ {0} wROADM «éuA”« OAcAYU bWt
b{E«%REGUAC " ROADM + ApOa&eziOwZ—>
<[o"0Xi*"ME

yi+wzc°ae U

Excessive filtering penalty on channel {0}.Please contact custom degidgh.
Ec {0} wNYc»aei-~ OALECAYU bWib{g§u»Uf-t
Z«-WOXi"ME

Cisco MetroPlanner DWDM

1o &4

OL-10358-01-J |



| cac =pAU Y¢- "

- Cc1 0d”

Yé-"" ¢ VE

Yc.’_n’ » O

Jau Yc.’_u’

yi+wzc°ae U

Filtering problem on channel {0}.Please contact custom degigh E ¢
{0} wWNYc»aei-tdJUK“tb{8u»Uf-tZ«-pn°
oXi"ME

yi+wzc°ae U

Excessive PMD on channel {0}.Please contact custom désigR.E ¢ {0}
WMPD U bWi1b{8u»Uf-tz«-p oXi*ME£E

¢ ZCA Y¢o MSTP shelves number in site {0} exceeds maximum MultiShelf configuration
(8).¢+ A {0} wMSTP3£¢N:U7GUc¢%3£¢NIR [8] »
Oa'oMthb£E

@ ZCA Y¢7 No linecards placed in Hybrid site {0} optical shdifE O ¢ A + A
{0} we3£¢Nta i §"AU "r"eoMIdeef

¢ ZCA Y¢o Release 4.7/5.0 does not support MultiSHeRelease 4.7/5.x U ¢ %23 £
¢cN>+U"A tdef

¢ ZCA Y¢o No PRE/BST card present with OSCM in site f0x. A {0} w OSCM t
PRE/BST§"AUK“tdcef

¢ ZCA Y¢o Layout not feasible for {0} Individual Shelf configuration - No room in the
optical shelf to host all the OTS units{0} wx 3£¢NIiRtO b
"¢ 7¢A>TqpVide{«3£¢Ntxb,ow OTS +">
YaVIZ"(eUK"“Fdoe £

¢ ZCA Y¢7 No space for DCU:unlock Site {0} layout.DCU wuO"pUsMwpz
+ A {0} we Z¢CAwéi«>rt oXi*ME

@ ZCA Y¢7 Hybrid Layout in Site {0} is allowed with Individual Shelf onty+ A {0}
pE Oxe¢A & 2¢AUDGswxx 3£¢cNwOUwiZp
bt

¢ ZCA Y¢7 Node protection is not allowed in Terminal Site {0}4z+ A {0} px
E"A-¢>—;pVidef

¢ ZCA Y¢7 DCC Chain in Site {0} is allowed with Individual Shelf ortyx A {0} p
DCC %E£"i>—;pV"wxx 3£¢NwOUiZpb£E

¢ ZCA Y¢7 Node protection in Site {0} is not allowed with Individual Shelf ordyt
A{0} wWE”A-¢xx 3£¢Npx—;pVideft

@ ZCA Y¢7 Cable DB part not identified in Site {0§.+ A {0} p-"O¢ DB &%
>Y pVidet

@ ZCA Y¢7 Site {0} layout must be unlocked to allow Patch Panel/DCU insertidr,
%IE¢ /DCUWAC>DOth"txz+ A {0} weé Z¢Aw
€e«>rth”"ZAUK“tbE

¢ ZCA Y¢7 Layout in site {0} cannot be built due an internal error.Other reports for the

same site may be wrong or incompleteee 0 4" U jYap+ A {0} w
¢ Z¢CA>"RpVide{%a+x Aw weU"A«j*“U
KIh“EiYtsloM"D6QUK"“tbE {Please contact support.

t+U"A>‘T oXi*ME

1. {n} x Cisco MetroPlannet‘10é.$s+"Et"V3Q '*1Db{
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C.1yAaNY ¢«
b{

C.1.1 y Wavelength Exceeded

U¢Di-wA8OG3a”AYi-

fw gxzE¢Aé"«f-tSZ"AANY ¢ «

UegPi-wddsr>b”0ut ®p

qAy :Cisco MetroPlannex zb,owE ¢, Aé " «listea”3ait'lopOUOab

"\g>/ *oMi$b{

TC2tzqAWRQ ' «"j¥S |[r>MO>0 " thb{

C-2 Wavelength Exceeded
BQ'*" ¥ MO
A&NY¢« AUiTAs>igb” 1-¢C%REGIiwEM&; ehip C"AYi->_
hStzaei- plix 32 T 1b{
XwpO>;u szZeys*® -
de >oues ys"# 1. Project Explorerw Service DemandN ¥¢cYipz~pb
e { "AUiA>E«ee i« z Sa"A8¢A  YcarT
" Edit >R 1b{
2. Path§&UpAeé;Ovici @ uAT’ Auto >-R°
¥b{
3. E¢Aé"«is>6lae thb{
@&i- pliu 16fthx 8" Eb"20E;ApAaANY ¢ « U¢eDi-wf-¢”
XwpO>;0 sZeys“t ¢>!Ez  %BEc:> XpV"'O3&i>»-R %
doee{ b{

1. Project Explorerw SubnetsN ¥ ¢ ¥4 p z Traffic Mapping >
2 %o "z System Release «a& ¢ « T b{

2. PropertiesO ipz C-Band Rulest hx L-Band Rulesw
Aé;O0wcei a@pAT’z Newrules! 034175
R Fb{

3. E¢Aé"«is>61ae th{

W Cisco MetroPlanner DWDM [ O &” 341 " A
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C.1.2 y Invalid Routing

qAy :Cisco MetroPlannex z ¢ ” A
¥, T'ZeoM”£ {

ClyAéNYo« UCD"‘WAé-Ogaé."AY|—.

Yi-UA®pK”"\q>/ "oMtbe¢E; A8«

TC3tzgAWRQ'¢"j¥sS |[r>MO>0"1b{

C-3 Invalid Routing
RQ'e"j¥a r>MoO
®@C7? E Aé"«pxza+” §M&; ehip ¢"AYi->_t tb{
- RS 2 A&7 "
! “M A 'IJZI beUM X A: ’L’Jze . 1. Project Explorerw Service DemandN ¥¢¥ipz~pb
wMy>: z a'ixiq "AUTA E«ae«'z  2E"AS.A YGaA'T
E6sM28M&; oMEb{ ' Edit >R $b{
2. Edit<AUiA >v, 72é-0¢«pw Path§aUpz
AésOwei @pAT’ Auto >-R Fb{
3. E¢Aé"«is>6lae tb{

C.1.3y Cannot Find Alternate Route

qAy :Cisco MetroPlannex z i p it
sM\g>/ "oMtb{

6:wEO E"AUK"hS tzE8¢"A>UZpV

T C4tzgAWRQ «"j¥sS | r>MO>0 " tb{

c-4

Cannot Find Alternate Route

BQ:.HJ‘% r>

MO

EO E"Apxd “RE¢>-

ipVsMwpz6:wEO E”
AU O'oM”Ouz b,o>U
iAA”U TA€ tb”\
gxpVidoe({

EO;6wMy>_ T fb{
1. Project Explorerw SitesN¥¢Ypz “pb”+ AtO
b” C-Band $hx L-Band »«&e¢ « tb{

2. PropertiesO® ip Functionality wAé ¢ O % ¢i
AT’ Auto >-R 1tb{

EcAé " «lis>61ee tb{

e u

3.
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C.1.4y Cannot Route Service

qAy :Cisco MetroPlannex zEO E"A& p+”Tp>¢”AYi-pVsM\qg>/ °

oMib{

TC5tzqAWRQ «"j¥uS |[r>MO>0"1b{

C-5 Cannot Route Service

RQ'*"|¥a r>MO

EO E"Apxd “RE¢>- ip ¢"AYi-w8M&;thxEO;6wMy>_t
pVsMwpz b,owz"Tp b

;;{AYI_‘b ‘axpVi g ¢”AYi-w8gM&;>_1tb”0u0

1. Project Explorerw Service DemandN ¥¢¥ipz~pb

"AUTA>Ecae¢é« z 33"A8¢ A YCA'T
' Edit =R tb{

2. Edit<AUiA > 2é-F¢«uw Path§dUpz
Aé:;Owei @pAT’ Auto >-R Ib{

3. E¢Aé"«lis>6Ta tb{

EO;6wMy>_ tb”Ou

1. Project Explorerw SitesN¥¢Ypz "pb”+ AtO
b” C-Band $hx L-Band >«&¢ « tb{

2. PropertiesO® ip Functionality wAé ¢ O % ¢i
AT’ Auto >-R 1tb{

3. E¢Aé"«is>6lae tb{

ey
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C.1.5y Overlapped Services Assigned to the Same Wavelength

qAy :Cisco MetroPlannex z %0 ap OtO6b”+"TuUA“po’soM”\q>/
oMib{

TC6tzgAWRQ ' «"j¥sS |[r>MO>0"1b{

C-6 Overlapped Services Assigned to the Same Wavelength
RQ'e"j¥a r>MoO
bOgM2UA“po’'sh°a > WeREcgipzip ¢c"AYi-wEM&;> T

wi-¢¥%REcUai-~ipO b"TzpO>_tb"TzithxfwtM>_1 1b{
stuloM#b{ g ¢"AYi-w8M&;>_tbh”0u0

1. Project Explorerw Service DemandN ¥¢¥ipz~pb
"AUTA>Ecae¢é« z 33"A8¢ A YCA'T
" Edit >-R 1b{

2. Edit<AUiA > 2é-F¢«uw Path§dUpz
Aé:;Owei @pAT’ Auto >-R Ib{

3. E¢Aé"«ls>61ae th{

hbOWEM&:> th"Ou

1. Project Explorerw Service DemandN ¥¢¥ipz~pb
"AUTA>E«eae¢« z 3a"A8¢ A YCarT
' Edit >=R 1b{

2. Edit<AUiIA >v 72é-@¢«pw  Wavelength§ &
UpzAé¢sOwiti a@pAT’ Auto =R 1b{

3. E¢Aé"«is>6lae tb{

C.1.6 y Protected Services Assigned to the Same Wavelength

qAy :Cisco MetroPlannex z %o ap Ot-¢+”TpUA“po’+oM”\q>/ oM
£b{

TC7tzgAWRQ ' ¢"j¥uS |[r>MO>0 " $b{

C-7 Protected Services Assigned to the Same Wavelength
RQ'*"j¥a r>MoO
@®in E¢Aé"«pxz-¢ P> WHREGPEM&;AshpO>_t 1b{

ei-A{wfegeUpO> 1
mcmA“potb{ %apOpo
W-Cx"TUUEMS$t&;

fcz 2n@®ATUAEDOS 2. Edit<AUTA >v 26-0 Wavelength§
Ao R N , . t< | >Ve 2670 «uwW aveleng a
SQJ{ZfWE(‘Ae «xtq /o UpzAé¢sOwiti a@pAT’ Auto =R ib{

3. E¢Aé"«is>6lae tb{

1. Project Explorerw Service DemandN ¥¢¥ipz~pb
"AUTA>E«eae¢« z 35"A8¢ A YCarT
" Edit >-R 1b{
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C.1.7 y Cannot Route Service Because of Add/Drop Constraints

qAy :Cisco MetroPlannex z10a O ¢ add/dropf +"WMyUj¥%pz+"Tus>c”AY
i=pVsM\qg>/ "oMtb/{

TC8tzgAWRQ ' ¢"j¥sS |[r>MO>0"$b{

~C-8 Cannot Route Service Because of Add/Drop Constraints

RQ'e"|Y r>MO

i0ad¢ add/dropE +"w8M& |u0ad¢ add/dropt+"wMy> “TVib{

a E"Awo %RE _ L . "
0z wo 7 ¢ 1. Project Explorerw SitesN¥¢%pz "pb”+t AtO

U-ipVsXs"OuUK*z  f b" CBand $hx L-Band >« ¢« b
WALz°ew¥%BE¢ ¢"AU . ,
TqAEGts tb{ 2. PropertiesO ip FunctionalitywAé¢ Ovati e

AT’ Auto >-R tb{
3. E¢Aé"«is>6lae tb{

C.1.8 y Design Requires a ROADM or Full Mux/Demux Site

qAy :Cisco MetroPlannex z f -z ROADM fhx Full Mux/Demux+ AUZApK*s
U'z ®s+ AUsM\qg>/ "oMifb{

TC9tzgAWRQ «"j¥uS |[r>MO>0"$b{

—C9 Cannot Route Service Because of Add/Drop Constraints

RQ "% r>MO

AaNY¢« UegbPin 2c°a@T |ROADM fhx Full Mux/Demuxewz¢ O-&"AtmMoz 1mZiwEg”
Upz¢7G+ A &S‘|é 2¢ Asfe oM"8§M&;Thxée¢w«s> t 1h{ ROADM 1 h x Full
AMyt "0£4a72t'"8§M& Mux/Demux sWE"Awz ¢ O-e"As>feb”UExziwgS“pb{
(q3pAU“7 M> Ob” " . . .
é@q F ,"3~\f‘_’T ’Z, y « + A;6U Add/Dropt G0AOEIEMSLf Aezt A » OU

stea “dl>_Mcs »S OADM t§MS$tf ~eoM”

\qUK*“tb{\w‘OsOuz? o - .

e 72:.0-e&"ArAltZ OADM +="Ux Apé¢«he”

c°efUpDo6s °wOfxz 1
mwe&E "™ A > N ¢ 0" E 1+AA;0S|» OwsM&:>1Eb"Ou

¢ ROADM * h x Full Mux/Demux£ t
7¢,0-e"Ab"\gpb{a”2
WEM&;fhx+"és«Uj¥p o ) . . ) ;
®sE"AU _mT'sTIhO 2. F\’ropertlesO ip FunctionalitywAés; Ow%e¢i eseuAT’ Auto >-R
0zOé-pU -"0zEg A& by

«xTqAEGOts“tb{ 3. TypewAé,O0%¢i a2uAT’ Auto >-R Fb{

4. E¢A8"«ilis>6Ta 1b{

1. Project Explorerw SitesN¥¢¥%ipz~pb”+ At0 b” C-Band %
hx L-Band >«a¢ « Tb{

OADM ="wé¢«>rtb”0Ou

1. Project Explorerw SitesN¥¢¥%pz“pb”+ Aw Add/Drop >« ee ¢
« tb{

2. Properties® ip PADM ForcingwAé¢sO%e¢i @pAT’ Auto >-
R fb{

3. E¢Aé"«is>6lae tb{
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C2yyi+wA&0O¢34a”"AYi-

fw gxzE¢ A8 «f-tSZ"yi+ EwdJls>r>b”Out ®pb{

C.2.1y Incompatible DCUs (C-Band)

C2yyi+wAdOc¢3a”AYi- ||

qAy : Cisco MetroPlannex z DCU w A& & U>/ oMt b{

T C-10tzqAWRQ %S [r>MO>0 tb{

~ C-10 Incompatible DCUs (C-Band)

BQ:.HJ‘% r>

MO

%°+ Aw DCUUTrj < SMF
nuée’04” wouz Owi,w
§uU 1600 psinm>OQoxs*

tdeef

§M&: DCUwW1m> “tXTzthx!E tb{

1. Project Explorerp C-Band Amplifiers >« a ¢ « 1 b{
2. PropertiesO ipz DCU1thx DCU2Aé;,O0%¢

%°t Ap DCUw» OUYs
"Ouz-;pV” DCU WE" U
“dxiw Otv ~efb{
DCU-E-200S ‘| DCU-100 f hx
DCU-E-350S ‘| DCU-100

i epACK MxfwtMET &~s DCU > =R
“ib{

3. E¢Aé"«is>6lae tb{

2 mwELEAF pé” 04"
DCU >%a+ Ap—;b”\q
xpVidoe({

C.2.2 y MMU Does Not Have Correct Amplifier (L-Band)

qAy :Cisco MetroPlannex zMMU >—;:b” L ITAE"AwOUuz OPT-AMP-L §"A>0

2770¢ PREES'|O"u»¢
tb{

BSTEqQ 0§MS$tf b”2AUK”\q>/ oM

T C11tzqAWRQ' ' «"j¥% S |r>M0O>0 tb{

T C-11 MMU Does Not Have the Correct Amplifier (L-Band)

BQ:.HJ‘% r>

MO

LiiAtSMoz MMU elLE”
Atz 1 mx PREz<O 1 mx BST
g ow 2mwOPT-AMP-L yi+
27tz Yyi+w8M&;UK"%

b{

E"Awyi+8M&;>_T 1b{
1. Project Explorerw Sites N¥¢¥%pz~“pb”+ Aw
L-Band Amplifiers >« & ¢ « £b{

2. PropertiesO ip PRES‘'| BSTAé;O0wuei e
MAT' Auto >-R tb{

3. E¢Aé"«lus>61ae th{
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C.2.3y MMU Does Not Have Correct Amplifier (C-Band)

qAy : Cisco MetroPlannexz MMU >—;b” CI1iA E"AtxzO&2i0¢ OPT-PREE
S'10"u»¢t OPT-BSTEWTMUZApPK”\q>/ oMb/

T C-12tzqAWRQ " %S [r>MO>0 tb{

T C-12 MMU Does Not Have the Correct Amplifier (C-Band)

BQ'e"jVa r>MO

CliApxz MMU >elL h |E"Awyi+8M&;>_ T tb{
E"Atx OPT-PRE(q OPT-BST
WtMUZApb{

1. Project Explorerw Sites N¥¢¥ipz~“pb”+ Aw
C-Band Amplifiers >« a ¢ « 1 b{

2. PropertiesO ip PRES‘'| BSTAé,O0wei e
MAT’ Auto >-R thb{

3. E¢Aé"«is>6lae tb{

C.2.4 y Output Power or Tilt are Out of Range

qAy : Cisco MetroPlannexz-R " hyi+wZ—fthx VUc“ZpK”\g>/ "o
Mtb{

T C-13tzqAWRQ %S [r>MO>0 tb{

~ C-13 Output Power or Tilt are Out of Range

BQ'e"jVa r>MoO

a"2U8M$t&; hz—1 §M$t&; he> TtTh"TIE 1b{
hx Vxz =-R”"ehZ¢°af
US‘|-R~A«hyi+w»
Ot,nXe0c“tK“+doe{

1. Project Explorerw SitesN¥¢Ypz “pb”+ AtO
b " C-Band Amplifiers f h x L-Band Amplifiers >
«ae« Th{

2. PropertiesO ipz FromFibreS‘| ToFibremazw
Tilt AéeOvti a@pAT’ Auto >-R fb{«
>E§M$t&:;b"Olz VcwvSx -3.0 ™+3.0
pb{

3. E¢Aé"«is>6lae thb{
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C.2.5y Invalid Fiber Values, Types, and Loss Values

qAy : Cisco MetroPlannex ziwMc+T>/ "oMtb{

e «Ne i Ozw» Othx<UA®
e «Ne Iw  Start Of Life¢ SOLEU- U End Of Life¢cEOLEU- a>isloM”

T C-14tzqAWRQ " j%S [r>MO>0 tb{

T C-14 Invalid Fiber Values, Types, and Loss Values

RQ'e"jYa r>MoO

€ b"OtwsM+ Apz n0 [ n0+w8M&;>_th"Tz thxn0+UY M w
+UEM&;"eoM1Ib{ Y MpOtadreoM"TrOT>=Y 1b{

1. Project Explorerw SitesN¥¢Ypz “pb”+ AtO
b " C-Band Amplifiers f h x L-Band Amplifiers >
«ae« Th{
2. PropertiesO ipziwMceT>Ta@ tb{
+ FromFibrenae 7w AttenuatorAé ¢ O%¢i @y
AT’ Auto >-R z8M&;>_ T th{
« nO+UY M wY MpOtadreoM”
TrOT>aY $b{Y XsMOuxz&~
t.Y $b{

3. E¢Aé"«is>61ae th{

C.2.6 y Attenuator Forcing Not Allowed

gAy : Cisco MetroPlannex z %2 RE¢cipn0+w8M&;UYS «sMwpziu0ald

¢add/dropE U”A>—;pVsM\g>/ "oMiEb{

T C15tzqAWRQ’«"j¥% S |[r>M0O>0 thb{

~ C-15 Attenuator Forcing Not Allowed

BQ'*"j¥ r>Mmo

Cisco MetroPlannet SM oz € nN0O+w8M&;>_th"Tz fthxnOo+UY M w
b”OtwsM+ Apz n0o+U |Y MpOtad”reoM”"TrOT>-Y $b{

M&;"soMitb - N
8 eoMED{ 1. Project Explorerw SitesN¥¢%pz "pb”+t AtO

b " C-Band Amplifiers f h x L-Band Amplifiers >
«a@« Th{
2. PropertiesO ipziwMceT>Ta@ tb{

e “pb yitw AttenuatorAé ¢ Ovu¢i @ pA
T' Auto >~Rtb{

« nO+UY M wY MpOtadreoM”
TroT>-Y $b{Y XsMOuxz&-~
t.Y $b{

3. E¢Aé"«is>6lae tb{
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C.2.7 y Unavailable Add/Drop Channels

qAy : Cisco MetroPlannexzn0+U O oM”Uziu0al¢

t—;pVsXsloM”\g>/ "oMifb{

T C-16tzqAWRQ %S [r>MO>0 1tb{

~ C-16

Unavailable Add/Drop Channels

add/dropE ¥ RE¢Ubp

BQ:.HJ‘% r>

MO

E¢Ae"«wzygO-e"A™z
«8 ZiAU _t2reht<T

T 'cziuoalbe add/dropE n
O+U8M&;*ehtttsl
oMiEb{

i0a0C¢ add/dropEnO0+wé¢ «>rt b{

1. Project Explorerw Sites N¥¢¥ipz~“pb”+ Aw
Client r«ee ¢« 1b{

2. Properties® ipz~pb” Rx S‘] Txn0+wA
€o0%¢T suAT’ Auto >-R ib{

3. E¢Aé"«is>6lae tb{

C.2.8 y Tilt Forced When No Tilt Design is Selected

qAy : Cisco MetroPlannex zE ¢ A& ” «p

No Tilt DesignU-R”"e0MsU’'zn0+t

VUEM&;"**oM"\gq>/ "oMiEb{

T C-17tzqAWRQ %S [r>MO>0 tb{

- C-17 Tilt Forced When No Tilt Design is Selected
BQ'e"jVa r>Mo
a”’2U 1 mithxoé:wnoO+ Ji+t8M&;"eh V>_T 1b{
vV &;"oMsU’ N . . - - .
T'It[§ ) I003~"S Ri ° 1. Project Explorerw SitesN¥¢%pz "pb”+t AtO
nbesign; O=at« 0 b” C-Band Amplifiers I hx L-Band Amplifiers >
M¥b{ «ae« Th{
2. PropertiesO ipz “pb yi+w Tit Aég Ovac

¢«<£ Project Explorerp No Tilt i @pAT" Auto >~R 3b{

DesignU-R"+*0oM"\ 3. EcAé"«ius>6Ta fb{

g>-Yb"txz Subnets

N ¥ ¢ ¥ w DWDM Design

Rulesf pz “pb”3pu

AU eae'Ur«wae ¢«

"ib{
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C.2.9y Cannot Replace 32-DMX with 32DMX-O

qAy : Cisco MetroPlannex za”2w8M & ;Uj%pzZAs 32-DMX T’ 32DMX-O w

I6UpVsM\g>/ "oMiIb/{

T C-18tzqAWRQ %S [r>MO>0 1tb{

~ C-18 Cannot Replace 32-DMX with 32DMX-O

BQ:.HJ‘%

r>

MO

Cisco MetroPlannex 32DMX-O
§"A>—;"*0q ¥ hUz
a’zt'lo 32-DMX §"AU
8§M&;"*oMib{fwALzZ
z4"UwalUYU\a"D6Q
UK“tb{thz%REcgtz
&"Us>f sMOuxzEg¢
A"« TuA”clItdJU
\a’"D6QUK“tb{

+ Apu0re"1REGtza"U>f b"Ouxz

10a0¢ add/dropEnO0+>—;pV”" Ot th{

1. Project Explorerw SubnetsN¥ ¢ % pz DWDM Design
Rules>2 % "z System Release «& ¢ « fb{

2. Properties O ipz No TXT/Line-Card RX Bulk
Attenuator Design w-=R>rt tb{

3. E¢Aé"«is>6lae tb{
BREctza"U>f "sMOuxz 32-DMX W8M &
>_T 1b{

1. Project Explorerw SitesN¥¢¥%pz“pb”+ Aw
Add/Drop >«ae¢ « Fb{

2. Properties® ip Demux AésOwei e pAT’
Auto >=-R 1 b{

3. E¢Aé"«is>6lae tb{
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C.2.10y Preamplifier Working in Invalid Mode
qAy : Cisco MetroPlannexzO & 2iOUA®sb”Ap "~ oM”\q>/ oMt

b {

T C-19tzqAWRQ %S [r>MO>0 1tb{

~C-19

Preamplifier Working in Invalid Mode

BQ:.HJ‘%

r>

MO

Oxez2iOUIée”"MsP”"Ap

A oOMEb{AANY ¢ « 0

Az«ut,nMoz «Ne TU
~.."hOuz thx+"U,E
*hOutz “%REcw x-A
Netdoe

Oaxz2iOw2wO”"u»Ua"2t'log§M$t None

tf "eoM”OUxzO"u»w None §M & ;> ¥
"ib{
1. Project Explorerw SitesN¥¢¥%pz “pb”+ AtO

b” C-Band Amplifiers f h x L-Band Amplifiers »
«ae¢ « Tbh{

2. Properties® ipz From Fibre¢e BSTEyi+w Tilt A
€o0%eT auAT’ Auto >-R tb{
3. E¢Aé"«ls>61ae th{

OaziOw2wpliiu 27 ™M30dBwc“°tK"Ouz
““{6"WGVM Cithx LIiA ¢’¢ 2c°afU
¢32Chs+5dBm/chksr£>—; $b{

1. Project Explorerw SubnetsN ¥ ¢ ¥4 p z Traffic Mapping >
2 %0 "z System Release «a& ¢ « 1 b{

2. PropertiesO ipz C-Band Rulest hx L-Band Rulesw
Aé;O0wcei a@pAT’z Newrules! 03475
R ¥b{

3. E¢Aé"«ius>61ae th{

piiu 30dB>0QhOuUze&”">stbh"\qxpV

Fdee{

C.2.11y Gain Too Low for an Amplifier

qAy : Cisco MetroPlannex z y i +

T C20tzqAWRQ " jVuS >

~ C-20

UybW"yipp "~ oM”"\g>/ "oM%tb{
MO>0 tb{

Gain Too Low for an Amplifier

BQ:.HJ‘% r>

MO

yi+U7-6—><s"yip

p " oMib{\wqgAxzy

bW uiithx4 " wade L
lTAwOuw " £U®  Use in-line
attenuator | O3&iU-R”"e0
MsM\igqqu~™~loC\b"”
\QUK*“$b/{

N0O+U8M&:~eoM”Ouz
UAY -"Oc¢tsloM”Ouxz
T tb{

fhx 14 in0+
NO+wW8M&;>r

1. Project Explorerw SitesN¥¢¥%pz“pb”+ Aw
Add/Drop >«ae¢ « Fb{

2. PropertiesO ip
" Auto >=Rfb{

Attenuator Aé ¢ Ovu¢i @ pAT

3.

EcAé «lis>61ee tb{
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C.2.12 y Gain Too High for an Amplifier

qAy : Cisco MetroPlannex zyi+ U6 bW ”yipp ~ oM”"\q>/ ~oM$b{
T C21tzqAWRQ' «"j¥% S |r>MO>0 tb{

T Cc-21 Gain Too High for an Amplifier

BQ'e"jVa r>Mo
yi+Uugdé—>is”yip NO+wW8M&;>rt 1b{
p"r oMiEb{

1. Project Explorerw SitesN¥¢¥%pz~“pb”+ Aw
Add/Drop »«ae ¢« fb{

2. PropertiesO ip AttenuatorAé s Ov¢i s puAT
" Auto >- R b{

3. E¢Aé"«is>61ae th{

C.2.13 y User Forcing Overridden

gAy : Cisco MetroPlannex za”2t'"§ M&;U+sD"esM\q>/ "oMIb{

C«E  \ox/ pK“zE¢AB " «Uifs ArUlere""ZpxK“tdee{

T C22tzqAWRQ’ «"j¥% S |[r>MO>0 tb{

~C-22 User Forcing Overridden

BQ'*" ¥ r>Mo

EcAe"«wzegO-e"Ald EsAe"«wze O-e"At Eb"Ouxz | wZ
t\w/ U O”shOuz Z¢é |hx Awéeworrt 1b{

'_|\” AAaNY, a1 ~ . Ry . -
O-¢ AUA"aNY<,«te -, |25xw TU"At E'oMoz sSTm TpuA”¢ |
>)Q"wpz THA"¢ la

A&Y"»>EypVsMOuxz Cisco MetroPlanner 2.5%

Y"»WEYUZApPpK”\qg> f->%Vib{

™ tph{\w/ xzb,ow
Z—>8M&;q 0

Cisco MetroPlanner 2.5 ¢ A & "
«> TU"A hKgp~ 0~
e"\q<K“tb{
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C.2.14 y Unsupported Configuration

qAy : Cisco MetroPlannex zyi+3hx OSC6\+ Aw:U bW"hStziRU=*
U”AresM\qg>/ "oMib{

T C-23tzqAWRQ %S [r>MO>0 " tb{

~ C-23 Unsupported Configuration

RQ'«"|% r>MO
SpAUAU“7>isloM f->.Y zus>6Tae fb{
Fb{

C.2.15y Channel Power Near the Fail Threshold

qAy : Cisco MetroPlannex z% RE¢ [é”"UEe.peé¢3ax"cAtUnMoM”\q
>/ “oM%Eb{

T C24tzqAWRQ " %S [r>MO>0 " tb{

T C-24 Channel Power Near the Fail Threshold

BQ'e"j¥a r>Mo
caewues3ax"cAUue.o §M&;>rt b{
— N e o ..
Z ng_,”OMiobqur fwA 1. Project Explorerw SitesN¥¢%pz "pb”+t AtO
ZECAG «wa T «& b” C-Band Amplifiers ¥ hx L-Band Amplifiers >
otePwza”UUC\b”D «EE{,«\:tb{
O0QUK"“tb{ o .
2. PropertiesO ip PRES‘'| BSTAésO0wei e
MAT’ Auto >-R thb{
3. E¢Aé"«is>6lae thb{

C.2.16 y Channel Power Below the Fail Threshold

qAy : Cisco MetroPlannex z% RE¢ [é”"UEe.peés3ax"cAs><sloM”\q
>/ "oMiIb{

T C-25tzqAWRQ’ " %S [r>MO>0 " tb{

~ C-25 Channel Power Below the Fail Threshold

BQ'e"jVa r>MO

+ AUOM"%RECG fer §M&;>rt ¥b{

U-"bWz Eepé¢3ax’eg _ . . .
1. Project Explorerw Sites N ¥ ¢ V- b”+ AtO

A>f pVide{ ) Xp I C7apz p

b " C-Band Amplifiers f h x L-Band Amplifiers >
«a« Th{

2. PropertiesO ip PRES‘'| BSTAé,O0wei e
MAT’ Auto >-R thb{

3. E¢Aé"«is>6lae tb{
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C.2.17 y OSC Channel Power Below the Fail Threshold

qAy : Cisco MetroPlannex z OSC %2 RE¢ (€"UEe.peé¢3ax"cAs<sloM”
\qzrtE A"« UTqEGPK™\g>/ “0fb{

T C26tzqAWRQ %S [r>MO>0 1tb{

~ C-26 OSC Channel Power Below the Fail Threshold

RQ "% r>MO
OSC%REgU " oMidoe{8§M&;>rt fh{

1. Project Explorerw SitesN¥¢Ypz “pb”+ AtO
b " C-Band Amplifiers f h x L-Band Amplifiers >
«ae« Th{

2. Properties® ip OSCwAésO%ti espuAT’
Auto >=R 1 b{

3. E¢Aé"«is>6lae tb{

OSCE«wC\ hpiiu 37dB>0QoM”Ouzan
a’>stb”\gxpVvVidoe{
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oeez> [Tib{ X ax Optical Signal-to-Noise Rati®dOSNR; «6 g0v;z£<«¢ dBfzy a
xés3”i"¢ Rxf£ié”«<¢ dBmEpb{ 3Swa iU "oaeZw¥,ts“tb{\s’

wa ixz i»"NE pU1Q’'«"7G BERCT¢A ©d” @&"Af tO b” ISO BER
AcwUA«pb{

« iw ISO-BERACtxz OL S| PLgMO2mw:UK“z OSNRMvVE OLES"|i&”
MvePLEGMO As 2m¥,> [ 1b{

e OSNRMV¥ wivxz i»"NE p fe”aUYpK“z\ex " raezwivp
(K“tb{Ug$sMytloz\wcx 35 ™M40dBtv Aetb{
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